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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Connect the ground lead of the probe to earth ground only.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

To Avoid Fire or
Personal Injury
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Terms in this Manual. These terms may appear in this manual:

WARNING.Warning statements identify conditions or practices that could result

in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in

damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbol may appear on the product:

CAUTION Refer to Manual WARNING
High Voltage

Protective Ground
(Earth) Terminal

Symbols and Terms
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Preface

This manual contains operating information for the TDSDDM2 Disk Drive
Measurements Application. The manual consists of the following chapters:

� The Getting Started chapter briefly describes the TDSDDM2 Disk Drive
Measurements Application, lists oscilloscope compatibility, and provides
installation instructions.

� The Operating Basics chapter covers basic operating principles of the
application and includes a tutorial that teaches you how to set up the
application to acquire a waveform, take measurements, and view the results.

The Application Examples section includes examples of tests and measure-
ments to give you ideas on how to solve your own measurement problems.

To show you how to operate the application using GPIB commands, this
chapter also contains a simple GPIB program.

� The Reference chapter includes a diagram of the menu structure and
descriptions of parameters.

� TheMeasurement Algorithms appendix contains information on measure-
ment guidelines and on how the application takes the measurements.

� The Track Profile Plots appendix contains information about using track
profile plots.

� The GPIB Command Syntax appendix contains a list of arguments and values
that you can use with the GPIB commands and their associated parameters.

Related Documentation and Online Help

You can access information on how to operate the oscilloscope and application
through the following related documents and online help:

Oscilloscope Information. The user manual for your oscilloscope provides
general information on how to operate the oscilloscope.

Programmer Information. The online help for your oscilloscope provides details
on how to use GPIB commands to control the oscilloscope.

Application Online Help. The application has an online help system that covers all
its features. You can access the help topics through a table of contents or index.
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Installation Manual. The Optional Applications Software on Windows-Based

Oscilloscopes Installation Manual contains the following information:

� Software warranty (same as in this manual)

� Software license agreement

� List of all available applications, compatible oscilloscopes, and relevant
software and firmware version numbers

� How to apply a new label

� Installation instructions based on the type of oscilloscope

� How to enable an application

� How to download updates from the Tektronix web site

NOTE. The installation manual contains up-to-date information and procedures.

Since installation procedures may be different for the TDS7000 series and

subsequent oscilloscopes, be sure to check the installation manual before you

install the application software.

You can find a portable document format (PDF) file of the installation manual in
the Documents directory on the Optional Applications Software on Windows-

Based Oscilloscopes Installation CD--ROM.

IDEMA Standard. The International Disk Drive Equipment and Materials

Association (IDEMA) 1995 Standards Binder, section T for Test Methods, is the
source document for test criteria used by theTDSDDM2 application. Polynomials
must be valid according to the 1995 IDEMA “white paper.”

Conventions

This manual uses the following conventions:

� This manual refers to the TDSDDM2 Disk Drive Measurements Application
as the TDSDDM2 application or as the application.

� This manual refers to any product on which this application will run as an
oscilloscope

� When steps require that you make a sequence of selections using the
application interface, the > delimiter marks each transition between a menu
and an option. For example, one of the steps to recall a setup file would
appear as Measururements>Save/Recall>Recall.
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Contacting Tektronix

Phone 1-800-833-9200*

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

Web site www.tektronix.com

Sales support 1-800-833-9200, select option 1*

Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com

1-800-833-9200, select option 3*
1-503-627-2400

6:00 a.m. -- 5:00 p.m. Pacific time

* This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.
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Product Description

The TDSDDM2 Disk Drive Measurements Application is a Java-based
application that enhances basic capabilities of some Tektronix oscilloscopes.

The application provides disk drive measurements, can display the results as
statistics or as a plot, and can save the results to a data log file.

Figure 1--1 shows an example of statistical results for a TAA measurement in the
application part of the display (lower half) and a Track Profile plot of those
results in the oscilloscope part of the display (upper half).

Figure 1- 1: TDSDDM2 Disk Drive Measurements Application

Compatibility
The Disk Drive Measurements Application is compatible with several TDS7000
series oscilloscopes. Table 1--1 lists the oscilloscopes and firmware version
numbers.

Table 1- 1: Compatible oscilloscopes

Model number* Firmware version

TDS7054 and TDS7104 1.2.0 or above

TDS7404 1.3.0 or above

TDS7254 1.3.1 and above

TDS5054 and TDS5104 1.0.0 or above

* For a current list, see the Software and Drivers category on www.tektronix.com.
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Requirements and Restrictions

The Sun� Java Run-time Environment V1.2.2 or above must be installed on the
oscilloscope to operate the TDSDDM2 application.

The TDSDDM2 application does not support hard disk drives that mark the
beginning of a track by the absence of a sector pulse.

NOTE. This application may be compatible with future models of oscilloscopes

that have different specifications. If this occurs, menus or options that are

unavailable will appear dim if they are beyond the acquisition capability of the

oscilloscope.

Updates Through the Web Site

You can find information about this and other applications at the Tektronix Inc.
web site, www.tektronix.com. Check this site for application updates and for
other free applications.

To install an application update, you will need to download it from the Tektronix
web site to the oscilloscope hard disk.

NOTE. More information about changes to the application or installation is in a

Readme.txt file on the web site. You should read it before you continue.

To download an application from the web site, follow these steps:

1. Access www.tektronix.com/Software & Drivers/Oscilloscopes.

2. Scroll through the files to the application that you want, select the file, and
download it to your hard disk drive. If necessary, unzip the file.

If your oscilloscope is connected to a network, you do not need to follow the
remaining steps.

3. If your oscilloscope is not connected to a network, copy the application from
the hard disk to blank, DOS-formatted floppy disks.

NOTE. To ensure that the files were downloaded successfully, always unzip the

files on a hard disk before copying them to floppy disks.

4. To install the application, refer to From Floppy Disks procedure on page 1--7.
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Accessories

There are no standard accessories for this product other than this manual.

To connect the Read Signal input to an oscilloscope channel, Tektronix
Differential Probes are recommended, such as the P6247 or P6248 probe for
TDS7054 and TDS7104 oscilloscopes, or the P7330 probe for a TDS7404
oscilloscope.
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Installation

This section contains information on the following tasks:

� Applying a new label

� Installing the TDSDDM2 application

� Enabling the application

� Connecting to a system under test

NOTE. The Optional Applications Software on Windows-Based Oscilloscopes
Installation Manual contains up-to-date information and procedures. Since

installation procedures may be different for the TDS7000 series and other

oscilloscopes, be sure to check this manual before you install the software.

You can find a portable document format (PDF) file of the installation manual in
the Documents directory on the Optional Applications Software on Windows-

Based Oscilloscopes Installation CD--ROM.

Applying a New Label

If you receive a newer version of this application, or purchase an application that
did not exist when you bought your oscilloscope, you need to apply a new label
to the rear panel of the oscilloscope. The label contains important information,
such as the serial number of the oscilloscope, options purchased for that serial
number, and an authorized Option Installation Key number. Each label is unique.

Figure NO TAG shows where to apply the new label on the back of a TDS7000
series oscilloscope.

Figure 1--3 shows where to apply the new label on the back of a TDS5000 series
oscilloscope.
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Label location

Figure 1- 2: TDS7000 series oscilloscope label location

Label location

Figure 1- 3: TDS5000 series oscilloscope label location

Installing the Application

Normally, the TDSDDM2 application resides on the hard disk drive of your
oscilloscope. However, you may still need to install the application software for
the following reasons:

� You receive an application introduced after you received your oscilloscope

� You have to rebuild the hard drive

NOTE. To operate the TDSDDM2 application, the Java Run-time Environment

(JRE) V1.2.2 or above must be installed on your oscilloscope.

If the JRE is not installed, a message displays when you try to start the

application. If the message appears, reinstall the JRE from the optional

applications compact disc (CD).
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To install the TDSDDM2 application from the optional applications software CD
for your instrument, follow these steps:

1. If the keyboard is not installed, connect it to the oscilloscope rear panel (the
optional-accessory keyboard plugs into the USB connector).

2. Power on the oscilloscope to start Windows.

3. Install the optional applications software CD in the CD-ROM reader on the
rear-panel of the oscilloscope.

4. Select the My Computer icon.

5. In the Exploring -- My Computer window, select the D: (CD-ROM) drive.

6. The Java Run-time Environment software must be installed before you can
install optional application software. If the Java Run-time Environment
software is already installed, skip to step 7; otherwise, follow these steps:

a. Select the Jre directory.

b. Select the .exe file in the Jre directory.

c. Accept all default settings recommended by the install program.

7. Select the Tdsddm2 directory.

8. Select the Setup.exe file to start the install program.

9. Follow the instructions given by the install program. The oscilloscope must
reboot to complete the installation process.

To install the TDSDDM2 application from floppy disk, follow these steps:

1. Power on the oscilloscope to start Windows.

2. Insert disk #1 in the floppy disk drive.

3. Select the My Computer icon.

4. In the Exploring -- My Computer window, select the A: (3 1/2 Floppy) drive.

NOTE. Additional information about the application or installation is located in

a Readme.txt file on the floppy disk. Read the file before you continue.

If you are updating the application, the Readme.txt file on the Tektronix web site

supercedes the Readme.txt file on the floppy disk.

5. Select the Setup.exe file to start the install program.

6. Follow the on-screen instructions.

From the Compact Disc

From Floppy Disks
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Wait until after the floppy disk drive LED has gone out to remove each
floppy disk and insert another.

7. When the installation is complete, the oscilloscope will restart. You need to
remove the final floppy disk when prompted.

Enabling the Application

You will need to enter the authorized Option Installation Key to enable the
application. The key is specific to the serialized oscilloscope and options for
which it was purchased.

NOTE. Do not enter this key until all application software that you have

purchased has been installed.

To enter the key number, follow these steps:

1. If the oscilloscope powered on in the toolbar mode (default), select the Menu
button (upper right corner of the display) to put the oscilloscope into
menu-bar mode. In menu-bar mode you should see a PC-style menu across
the top of the display.

2. Go to the Utility menu in the menu bar and select Option Installation.

3. Follow the on-screen instructions to enter the alphanumeric key number
exactly as it is printed on the rear-panel label. Figure NO TAG on page
NO TAGNO TAG shows the location of the label on the back of the
oscilloscope.

Connecting to a System Under Test

For best signal accuracy, you should use one differential probe and two standard
probes. For connection to the Read signal, use a differential probe, such as the
Tektronix P6247 or P6248 probe for TDS7054 and TDS7104 oscilloscopes, or
the P7330 probe for a TDS7404 oscilloscope. For connection to the Index and
Sector signals, use standard oscilloscope probes, such as the P6139A passive
probe or P6243 active probe for TDS7054 and TDS7104 oscilloscopes, or the
P7240 active probe for a TDS7404 oscilloscope.
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Table 1--2 shows the default channel-to-signal assignments. You can change the
channel assignments to match your configuration.

Table 1- 2: Primary setup channel assignments

Channel Description

Ch 1 Read signal from the disk drive preamp channel

Ch 2 Read Gate signal (optional)

Ch 3 Sector pulse, marking the beginning of the sector on the track

Ch 4 Index pulse, marking the beginning of the track

NOTE. The TDSDDM2 application does not support disk drives that mark the

beginning of a track by the absence of a sector pulse. For this case, a timeout

trigger setup is needed to identify the beginning of the track.

There are two connection configurations, primary and secondary.

WARNING. To avoid electric shock, you must ensure that power is removed from

the SUT before attaching a probe to it. Do not touch exposed conductors except

with the properly rated probe tips. Refer to the probe manual for proper use.

Power down the SUT before connecting probes to it.

Use the primary setup if you want the oscilloscope to control the disk measure-
ments. The primary setup is used for most configurations. Connect the disk drive
to the oscilloscope as shown in Figure 1--4.

Test oscilloscope

Disk drive

CH 1 CH 4

Index signal (standard probe)

CH 3

Read signal (differential probe)

Sector signal (standard probe)

Figure 1- 4: Primary setup connections

Primary Setup
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When using the secondary setup, you must specifically program the test
measurement control sequences. Refer to the GPIB Program Example section
and to the GPIB Command Syntax appendix in this manual for more information
on how to control the application with a GPIB program.

Connect the disk drive to the oscilloscope as shown in Figure 1--5.

Test oscilloscope

Disk drive

CH 1 CH 2

Read signal (differential probe)

Read Gate signal (standard probe)

Figure 1- 5: Secondary setup connections

Secondary Setup
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Configuration

This section describes configuration tasks that you should perform before you
start taking measurements. For the most part, these tasks configure the oscillo-
scope and Disk Drive Measurements Application to correctly acquire the signals
from the disk drive under test. You can find more information on setup parame-
ters for specific measurements in the Parameters section on page 3--3.

Setting Up the Oscilloscope Trigger

If you use the Read Gate, User, or Index Trigger mode in the application, you
must manually set up the oscilloscope trigger. To do so, follow these steps:

1. Connect the Index, Sector, and Read signals to Ch 4, Ch 3, and Ch 1
respectively.

2. Go to Math in the oscilloscope menu bar and select Spectral Controls> T tab.
Figure 1--6 shows the T tab.

Figure 1- 6: Spectral Control T tab for a TDS7104 oscilloscope
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3. Use the Multipurpose (MP) knobs to set the Sample Rate to 500 MS/s,
1.25 GS/s, 2.5 GS/s, 5 GS/s, or 10 GS/s.

4. Use the MP knobs to set the Record Length to 50,000, 100,000, 200,000 or
400,000.

For NLTS measurements, set the Record Length to at least 200,000.

5. Set up the trigger:

a. Go to Trig in the menu bar, access the A Event (Main) Trigger Setup
menu, select the A Event tab, and set the Coupling to DC.

b. Set the Slope to the appropriate edge for your disk drive signals, rising
or falling.

c. Set the Level to an appropriate level for your disk drive signals, or select
Set 50%.

d. Select the Mode tab, and set the Trigger Mode to Normal.

e. Set the Holdoff to Auto.

Setting Up the Application Trigger

Before you begin to take measurements, you should specify the following trigger
parameters:

� Trigger mode, which selects the input trigger signal

� Start Sector and Stop Sector (used with the Sector Trigger mode only),
which specifies the range of sectors to be measured

� Preamble (used with the Sector Trigger mode only), which the application
uses to avoid acquiring the preamble

Set up the trigger parameters as follows:

1. Start the application. Go to the File menu in the oscilloscope menu bar and
select Run Application> Disk Drive Measurements 2.
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2. Select Inputs> Input/Trigger and select one of the following Trigger Modes:

Sector Select Sector mode if you want to perform a measurement
over a range of sectors rather than over the entire track. The
application sets up the following oscilloscope trigger con-
trols:

A Event trigger -- the Source is the Index Pulse

B Event trigger -- the Source is the Sector Pulse

A --> B Seq trigger (delayed trigger) -- the Trig Event is the
Start Sector number, Horiz Delay is On, and the Trig on nth
event is the Preamble duration

Read Gate Select Read Gate mode if you want to trigger on the Read
Gate signal. The A --> B Seq is not used with this selection.

User Select User mode if you want to use your own custom trigger
setup. When you select User, the application does not set up
the oscilloscope trigger controls.

User is the default Trigger Mode selection.

Index Select Index mode if you want to trigger on the Index Pulse
signal. The A --> B Seq is not used with this selection.

NOTE. If you select the Read Gate, User, or Index Trigger mode, you must

manually set up the oscilloscope trigger as described on page 1--11.

3. For the Sector Trigger Mode, use the MP knob (or keypad) to select values
for the Start Sector and Stop Sector options. Figure 1--7 shows the default
values.

Multipurpose knob icon

Figure 1- 7: Sector Trigger Mode default values
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NOTE. The A --> B Seq trigger has a minimum count setting of 1. If you want to

trigger on sector 0, you must enter the value of N, where N is the total number of

sectors on the track. The first Sector Pulse after the Index Pulse is sector 1.

Figure 1--8 shows how the sectors are numbered with respect to the B Event
trigger in the oscilloscope application.

Sector 0 preamble

Sector 0 data

Index pulse

Sector N--1

Sector 3 data

Figure 1- 8: One track

4. For the Sector Trigger Mode, set the Preamble option. Use the MP knob (or
keypad) to select a value that is greater than the actual signal preamble
duration. This ensures that the application does not acquire the preamble and
excludes it from the measurement.

Hysteresis

Many of the measurements search for a local event called a peak and trough pair.
You can set the hysteresis level so that noise will not cause false identification of
peaks in the Read waveform. For a peak or trough to be found, the signal must
be greater than the hysteresis level.

The application uses the value of the Hysteresis option in many measurements,
such as TAA, PW50, Asymmetry (for TAA Snapshot and PW50 Snapshot
measurements), Overwrite, Resolution, and Baseline Shift.

Figure 1--9 shows how to use the hysteresis to avoid false identification of peaks
and troughs.
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Signal

Hysteresis
setting

Noise

Peak

Trough

Figure 1- 9: Using hysteresis to avoid false identification of peaks

To set the hysteresis levels, follow these steps:

1. Select Inputs> General.

2. Use the multipurpose knob (or keypad) to select a value in the Hysteresis
option.

The units for hysteresis are in divisions. The application uses the value for both
the positive hysteresis level and the negative hysteresis level. For example, if
you select a value of 2 divisions, the hysteresis levels are set to +2 divisions and
--2 divisions above and below the waveform baseline.

Figure 1- 10: Hysteresis option
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Configuring the Input Waveforms

Your configuration may not match the TDSDDM2 waveform assignments.
Table 1--3 lists the default channel assignments.

Table 1- 3: Default channel assignments

Description Channel

Read signal from the preamp channel Ch 1

Read Gate signal (optional)* Ch 2

Sector Pulse, marking the beginning of the sector on the track** Ch 3

Index Pulse, marking the beginning of the track** Ch 4

* Uses this signal when you select the Read Gate Trigger Mode.

** Uses these signals when you select the Sector Trigger Mode.

NOTE. Oscilloscope channels (Ch1, Ch2, Ch3, and Ch4) connect to real, live

signals (waveforms) as opposed to waveforms that have been saved as .wfm files

and can be recalled into reference memory (Ref1, Ref2, Ref3, and Ref4).

If necessary, you can reconfigure the input waveforms to match your disk drive
configuration. To do so, follow these steps:

1. Go to the Inputs menu in the menu bar and select Input/Trigger. Figure 1--7
on page 1--13 shows the Inputs/Trigger menu.

2. Use the list box for each signal and select the waveform that matches your
configuration.
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Basic Operations

This section contains information on the following topics and tasks:

� Application interface

� Using basic oscilloscope functions

� Setting up the application

� Taking measurements

� Warning messages

� Analyzing the results

� Saving the results to a file

� Viewing a data log file

� Saving and recalling setups

� Exiting the application

Application Interface

The application uses a Windows type of interface. Figure 2--1 shows the Menu
bar and some of the buttons and boxes that you use to operate the application.

Menu bar

Command
button

List box

Area

Option

Figure 2- 1: Application interface

NOTE. The oscilloscope application shrinks to half size and appears in the top

half of the display when the application is running.
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Table 2--1 lists the interface items with a brief description of each.

Table 2- 1: Application interface items

Item Description

Menu bar Located at the top of the application display and contains application menus

Area Visual frame that encloses a set of related options

Option button Button that defines a particular command or task

List box Box that contains a list of items from which you can select one item

Box Box that you can use to type in text, or to enter a value with the Keypad or a
Multipurpose knob

Scroll bar Vertical or horizontal bar at the side or bottom of a display area that can be
used for moving around in that area

Browse Displays a window where you can look through a list of directories and files

Command button Button that initiates an immediate action

NOTE. For a quick overview of the complete menu structure, refer to Figure 3--1

and Figure 3--2 starting on page 3--1.

Using Basic Oscilloscope Functions

You can use the Help menu to access information about the application. You can
also use other oscilloscope functions and easily return to the application.

The application includes Online Help about the application menus and controls.

To display the Online Help, follow these steps:

1. Choose the Help menu from the TDSDDM2 menu bar.

2. Use the Contents, TOC, or Index tabs to navigate through the help.

The application remains displayed when you minimize the oscilloscope. To
minimize the application, select Measurements> Minimize.

To maximize the application, select TDSDDM2 in the Windows toolbar.

Using Online Help

Minimizing and
Maximizing the

Application
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When you access oscilloscope functions, the oscilloscope fills the display. You
can access oscilloscope functions in the following ways:

� Select the Close button in the application display

� Choose the Menu-bar or Toolbar mode on the oscilloscope and access menus

� Press front-panel buttons

To return to the application, choose the App button. Figure 2--2 shows the App
button.

To return to the application, choose the App button

Figure 2- 2: Returning to the application

The application uses directories to save and recall setup files and also uses
extensions appended to file names to identify the file type.

Default Directories. Table 2--2 lists default directory names.

Table 2- 2: Default directory names

Directory name Used for

C:\TekApplications\tdsddm2 Home location

C:\TekApplications\tdsddm2\data Data log files

C:\TekApplications\tdsddm2\setups Setup files

C:\TekApplications\tdsddm2\waveforms Waveform files

File Name Extensions. Table 2--3 lists file name extensions used or generated by
the application.

Table 2- 3: File name extensions

Extension Type

.csv Log file that uses a “comma separated variable” format

.ini Application setup file

.set Oscilloscope setup file saved and recalled with an .ini file; both files will
have the same name

.wfm Waveform file that can be recalled into a reference memory

Returning to the
Application

Application Directories
and File Names
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Setting Up the Application

You can set up the application to take disk drive measurements from the SUT,
you can plot the results, and you can save the statistical results to a data log file.

There are four Measurements menu items. Two allow you to select and configure
a measurement, one allows you to save and recall measurement setups, and one
allows you to minimize the application.

TAA/PW50 Measurements Menu. To access the TAA/PW50 Measurements menu,
go to the Measurements menu in the menu bar and choose TAA/PW50.
Figure 2--3 shows the TAA/PW50 Measurements menu.

Figure 2- 3: TAA/PW50 Measurements menu

Table 2--4 lists the TAA/PW50 measurements with a brief description of each.

Table 2- 4: TAA/PW50 measurement options

Option Description

TAA Track Average Amplitude: average peak-to-peak value of data from the
Read signal input

TAA+ Average positive peak value

TAA-- Average negative peak value

TAA Snapshot Provides a summary of TAA measurements

PW50 Pulse Width at 50% of the Peak Amplitude: average pulse width at 50% of
the peak, that includes both peaks and troughs; can also measure around a
complete track if specified in the oscilloscope trigger setup

PW50+ Includes only the positive peaks

Selecting a Measurement
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Table 2- 4: TAA/PW50 measurement options (Cont.)

Option Description

PW50- Includes only the troughs

PW50 Snapshot Provides a summary of PW50 measurements

Limit Test Area. Table 2--5 lists options in the Limit Test area with a brief
description of each. For some measurements, such as TAA, PW50, Overwrite,
Resolution, and Baseline Shift, these are the only options.

Table 2- 5: Limit Test options

Option Description

On/Off Enables the application to display PASS or FAIL results based on the limits

Upper Limit Maximum limit allowed for the measurement mean value

Lower Limit Minimum limit allowed for the measurement mean value

Figure 2--4 shows the methods you can use to enter Limit Test values.

Keypad

Multipurpose knob icon

Keypad icon

Minimum value button

Maximum value button

Figure 2- 4: How to enter Limit Test option values

Table 2--6 lists methods that you can use to enter values for Limit Test options.

Table 2- 6: Limit Test entry methods

Entry method Description

Keypad Icon appears when you select the box; select and use to enter a value

Multipurpose knob When you select the multipurpose (MP) knob, a line appears between
the knob and the box; turn the knob on the oscilloscope to select a value
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NLTS/Other Measurements Menu. To access the NLTS/Other Measurements menu,
go to the Measurements menu in the menu bar and choose NLTS/Other.

Figure 2--5 shows the NLTS/Other Measurements menu.

Figure 2- 5: NLTS/Other Measurements menu

Table 2--7 lists the NLTS/Other measurement options with a brief description of
each.

Table 2- 7: NLTS/Other Measurements options

Option Description

NLTS Initial Non-Linear Transition Shift; measures NLTS caused by a transition in the
current bit cell which reverses the direction of the previous magnification

NLTS 1st Adjacent Measures NLTS caused by a transition in the previous bit cell which
opposes the transition in the current bit cell; also called the first adjacent

NLTS 2nd Adjacent Measures NLTS caused by a transition which is two bit cells before the
current bit cell; also called the second adjacent

NLTS Snapshot Provides a summary of NLTS measurements

SNR Signal-to-Noise Ratio; determines the ratio of the variance of the readback
signal to the readback noise and expresses the ratio in dB units

Asperity Large signal caused when the disk drive head strikes the media; the
application compares the mean value of TAA samples to the amplitudes of
peak/trough pairs and saves values that exceed the Threshold option; also
saves the sector number and time relative to the start of the waveform
data record

Overwrite Determines the amount of residual signal remaining from a previous write
when new data is written to the same location
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Table 2- 7: NLTS/Other Measurements options (Cont.)

Option Description

Resolution Determines the ratio of a high-frequency TAA pattern to a low-frequency
TAA pattern, expressed as a percentage (write a low-frequency TAA
pattern to a track, measure it, erase it, write a high-frequency TAA pattern
to the same track, and measure again)

Baseline Shift Difference between the baseline of the positive pulse and the baseline of
the negative pulse

Figure 2--6 shows the parameter options for NLTS measurements.

Polynominal Polynominal index

Figure 2- 6: NLTS Parameter options

Table 2--8 lists the NLTS Parameter options with a brief description of each.

Table 2- 8: NLTS Parameter options

Option Description

Pattern Dur Initial length of time for one repetition of the pseudo-random bit data pattern;
enter your best estimate

Dur Toler Tolerance (accuracy) of the initial value in the Pattern Dur option; a smaller
percentage helps the application take the measurement more quickly

Poly Index Application uses x=2 to obtain condensed notations of selected pseudo-ran-
dom binary sequence polynominals; you should use the same polynominal
that generates the data pattern written to the media; when you use the
multipurpose knob, invalid polynominals do not appear as selections
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NOTE. The application initially uses the estimated value that you enter for the

Pattern Dur option. The application then uses autocorrelation to precisely

measure the duration pattern and replaces the estimated value.

Figure 2--7 shows an example of how the application uses x = 2 to calculate the
polynominal index.

Polynominal = x9
+ x4

+ 1

Polynominal index = 2
9
+ 2

4
+ 1 = 529

Figure 2- 7: How the application calculates the polynominal index

Figure 2--8 shows the parameter options for the SNR measurement.

Figure 2- 8: SNR Parameter options

Table 2--9 lists the SNR Parameter options with a brief description of each.

Table 2- 9: SNR Parameter options

Option Description

Pattern Dur Number of bits per pattern period for general patterned data, depending on
what was previously recorded on the hard disk

For pseudo-random data of pseudo-noise type generated with shift registers
(pseudo-random binary sequence), number of bits per pattern is 2L-1, where
L is the order of the characteristic polynominal

Dur Toler Same as in Table 2--8

Bits/Pattern Periodic signals used for SNR measurements defined as isolated periodic
transitions (low frequency), isolated high-density periodic transitions (high
frequency), or patterned data such as pseudo-random sequences; use two
bits per pattern for low-frequency and high-frequency patterns
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The value for the Threshold option determines if the application identifies a
signal as an asperity. Figure 2--9 shows the Threshold option.

Figure 2- 9: Asperity Parameter options

There are three Inputs menus: Inputs/Trigger, Inputs Filters, and Inputs General.

Inputs/Trigger. To configure the input waveforms for a measurement, go to the
Inputs menu in the menu bar and choose Inputs/Trigger. Figure 2--10 shows the
Inputs/Trigger menu.

Figure 2- 10: Inputs/Trigger menu

Table 1--3 on page 1--16 lists the default channel assignments. The application
has the following Input Channels options:

� Read Signal: a waveform that performs a read operation from a sector

� Read Gate: a waveform that indicates the beginning of a read operation; the
application Trigger mode must be set to Read Gate to use this input

Configuring a
Measurement
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� Sector Pulse: a waveform that indicates the beginning of a sector; the
application Trigger mode must be set to Sector to trigger with this and the
Index Pulse inputs

� Index Pulse: a waveform that indicates the beginning of a track; the
application Trigger mode must be set to Index or to Sector to trigger with
this input

Table 2--10 lists the Trigger options with a brief description of each.

Table 2- 10: Trigger options

Option Description

Mode

Sector Triggers on the Sector Pulse and Index Pulse inputs; uses oscilloscope
delayed triggers to monitor various sectors

Read Gate* Triggers on the Read Gate input; since delayed triggers are not used, you
must program the disk drive to sequence through a range of sectors and
leave a delay that is long enough for the application to take a measurement

User* Uses the oscilloscope trigger exactly as specified

Index* Triggers on the Index Pulse input; oscilloscope delayed trigger is not used

Preamble** Time required to initialize a disk drive before signals become stable; the
duration of the preamble varies between disk drive manufacturers

Start Sector** Specifies the sector on which to start the measurement

Stop Sector** Specifies the sector on which to stop the measurement

* Refer to Setting up the Oscilloscope Trigger on page 1- 11.

** Only available when Sector is the trigger mode.

NOTE. For more information on how the application Trigger modes affect the

oscilloscope trigger controls, refer to step 2 on page 1--13.

Filters.You can modify the Read Signal input by applying filters that block
specific frequency bands. You can configure each filter as a Highpass filter to
block out the low frequency band, or as a Lowpass filter to block out the high
frequency band. You can also configure the filters by selecting a Slope and a
Cutoff Frequency based on the sample rate.

To configure a filter for a measurement, go to the Inputs menu in the menu bar
and choose Filters. Figure 2--11 shows the Inputs Filters menu.
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Figure 2- 11: Inputs Filters menu

Table 2--11 lists options for Filter 1 and Filter 2 with a brief description of each.

Table 2- 11: Filters options

Option Description

On/Off Enables the application to use a filter as defined by the remaining options

Cutoff Freq Excludes frequencies above (Low pass filter) or below (High pass filter) the
value specified for measurements

Update Updates the Cutoff Freq value if you change the sample rate (Horizontal
Scale knob) of the oscilloscope

The Min and Max values show the range for the Cutoff Freq option; the Min
value is 5% of the sample rate and the Max value is 35% of the sample rate

Type

High pass Blocks the low frequency band and passes on only the high frequency band
of the waveform

Low pass Blocks the high frequency band and passes on only the low frequency band
of the waveform

Slope Defines the slope of the filter in dB/octave units

Store In Selects the reference memory in which to store the filtered waveform, if any

Figure 2--12 shows the filter characteristics of the various filter options.
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Lowpass

Frequency

Cutoff freq.

Frequency

Highpass

Slope

3 dB

24 dB/Oct

Magnitude

3 dB

Magnitude

Frequency

3 dB

12 dB/Oct

24 dB/Oct

36 dB/Oct

48 dB/Oct
84 dB/Oct

72 dB/Oct

60 dB/Oct

Magnitude

Figure 2- 12: Filter characteristics

Using Both Highpass and Lowpass Filters. When you use both filters, the
application first applies Filter 1 to the Read Signal input and then Filter 2. You
should be aware that you can select a Cutoff Frequency value that filters out the
entire waveform or all but a small amount of noise. Figure 2--13 shows the
spectrum of the waveform passed to take measurements when you use both the
Highpass and the Lowpass filters.

Highpass
Lowpass

3 dB

Cutoff frequency
Cutoff frequency

Pass band

Frequency

Magnitude

Figure 2- 13: Using both Highpass and Lowpass filters
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Filtering Transient Responses. At the beginning and end of the filtered wave-
form, there will be a transient response caused by the response of the filter to a
discontinuity. You can use Gating in the Inputs General menu to exclude the
discontinuity from the measurement calculations. To do this, follow these steps:

1. Select Inputs> Filters> On> Store In and the desired reference memory,
Ref1, Ref2, Ref3, or Ref4.

2. Select Single Mode and press to start the measurement sequence.

3. Remove the Read Signal input waveform from the display. If the input is a
channel, press the front-panel channel button to remove the waveform.

4. Observe the displayed Ref waveform and verify that the amplitude is correct.

You can see transient responses at the beginning and end of the waveform.

5. Select Inputs> General> Gating> On.

6. Move the vertical cursors so that there are no transient responses between
them; this excludes the transient responses from the measurement.

7. Press to start the measurement sequence.

8. Repeat step 3 to remove the Read Signal waveform from the display.

9. Observe the displayed Ref waveform. If necessary, adjust the Cutoff
Frequency value; steeper slopes yield longer transient responses.

10. If necessary, repeat step 6.

11. Select Inputs> Filters> Store In> None. The application will display
measurement results faster when reference memories are not used.

Cutoff Frequency Values and Sample Rate. When you start the application, or
recall the default setup, the application uses the current oscilloscope sample rate
to calculate a Min and Max range for Cutoff Frequency values. The Min and
Max range displays at the bottom of the Inputs Filter menu. The application also
sets the Lowpass filter to 15% of the sample rate and the Highpass filter to 10%.
You can adjust the Cutoff Frequency value within the Min and Max range.

When you change the sample rate and choose the Update command button, the
Min value is set to 5% of the sample rate and the Max value is set to 35% for
both filters. The application retains the value of the Cutoff Frequency if it is
within the updated range. If the value is outside the updated range, the applica-
tion adjusts the Cutoff Frequency to the closest value within the updated range.
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NOTE. If the value of the Cutoff Frequency is below the updated range, the

application sets it to the Min value. If the value is above the updated range, the

application sets it to the Max value.

To change the sample rate and adjust the filter frequencies, follow these steps:

1. Use the Horizontal Scale knob on the oscilloscope to change the sample rate.

2. Choose the Update command button for either filter. The Min and Max
values for both filters change relative to the new sample rate.

3. Adjust the Cutoff Frequency value according to your needs.

General. To configure the hysteresis or the gating for a measurement, go to the
Inputs menu in the menu bar and choose General. Figure 2--14 shows the Inputs
General menu.

Figure 2- 14: Inputs General menu

Table 2--12 lists the General options with a brief description of each.

Table 2- 12: General options

Option Description

Hysteresis Filters out noise that could cause false identification of peaks; refer to Figure 1--9
on page 1--15 for more information

Gating Area between cursors on the waveform from which measurements are taken



Basics Operations

TDSDDM2 Disk Drive Measurements Application User Manual 2- 15

Taking Measurements

If you want to change trigger settings or localize the measurement, you should
do so before you take any measurements.

NOTE. If you select a reference or a math waveform as the source, you will need

to recall and display the waveform before the application can take a measure-

ment. For information on how to do this, refer to Recalling a Waveform File on
page 2--26.

Remember to select Reset to set the results to zero if you change the oscilloscope

Vertical or Horizontal time settings between measurements.

The Sequence Control menu is always accessible in the lower right part of the
application display. Figure 2--15 shows the Sequence Control menu.

Start button

Reset button Pause button

Stop button Continue
button

Sequence Mode

Figure 2- 15: Sequence Control menu

To acquire data from waveforms, follow these steps:

1. Select a Sequence mode. See Table 2--13.

Table 2- 13: Sequence Control menu

Option/button Description

Mode

Single

Free Run

If the input source is Ch1, Ch2, Ch3, or Ch4, the application acquires a new
waveform(s); for all sources, the application performs measurements on the
waveform(s) and stops

Repeatedly acquires the input waveform(s) and takes measurements

Start/Continue
button

Starts to take measurements from the input waveform(s)
When paused, continues taking measurements

Taking New
Measurements
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Table 2- 13: Sequence Control menu (Cont.)

Option/button Description

Pause button Pauses and resumes when you select the Continue button or stops when
you select the Stop button

Stop button Stops taking measurements

Reset button Resets all result values to zero

2. Press to start the measurement sequence.

NOTE. Do not change oscilloscope settings while a measurement is being taken

since this can cause an invalid measurement.

By specifying the trigger position, the starting point, and the length of the
waveform, you can effectively filter out information that is not useful to analyze
before taking a measurement. Refer to Setting Up the Oscilloscope Trigger on
page 1--11 for information on how to adjust the Record Length and Sample Rate
in the Math> Spectral Controls menu (T tab) on the oscilloscope.

An Alternative Method. There is another way to control the amount of data to
measure without using gated cursors or specifying a range of sectors. You can do
this by adjusting the Preamble Duration in the application Sector menu and the
Record Length or Horizontal Scale in the oscilloscope horizontal menu. By
specifying both the starting point and the total length of the measurement in this
way, you can effectively size the area of interest.

NOTE. If an error message displays because there are not enough cycles from

which to take a measurement, you should increase the Record Length or the

Horizontal Scale.

Analyzing the Results

You can view the results as statistics or graphically as a plot. Figure 2--16 shows
an example of the results display formats.

Localizing Measurements
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NOTE. Stop the acquisition before viewing the results as plots if you are taking

measurements in the Free Run mode.

Figure 2- 16: Results as statistics and as a Track Profile plot

You can also log the data to a .csv file for viewing in a text editing, spreadsheet,
database, or data analysis program. Figure 2--17 shows an example of how a
.csv file might look in a spreadsheet program.

Figure 2- 17: Example of viewing data in a .csv file

NOTE. Statistical results vary widely across the different measurements. Because

of this, each measurement has a unique format for the statistics in a log file.
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To access the View Results menu, go to the View menu in the menu bar and
choose Results. Refer to the Applications Examples section to see examples of
statistical results for each type of measurement.

The statistical information that displays will vary by measurement. In general,
the View Results menu contains statistical values for the mean, the maximum
(Max), the minimum (Min), the standard deviation (StdDev), the SNR statistics
(StatSNR), the number of peaks, troughs or peak/trough pairs used for the
average values (num avg), and the sector number.

There is one plot format: Track Profile. The format plots the results such that the
vertical axis represents the mean measurement value and the horizontal axis
represents the measurement number.

To access the Plot Track Profile menu, go to the Plots menu in the menu bar and
choose Track Profile. Figure 2--18 shows the Plot Track Profile menu.

Figure 2- 18: Plot Track Profile menu

Table 2--14 lists the Plot Track Profile options with a brief description of each.

Table 2- 14: Plot Track Profile options

Option Description

On/Off Enables the application to plot track data

Store Profile In: Selects the reference memory in which to store data for the plot

Reset Clears all data in the plot

Viewing Statistics

Viewing Plots
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When the application trigger mode is set to Sector, the Plot Track Profile menu
also contains the following readouts:

� Value at Cursor displays the measurement value and is in units relative to the
measurement (V, Mhz, dBs).

� Sector at Cursor displays the measurement number or the sector number at
the cursor

For more information on Track Profiles, refer to Creating and Viewing Track

Profile Plots on page 2--45.

To reset all results to zero, choose the Reset button in the Sequence Control
menu. You do not have to wait for a measurement to complete to reset the
results.

Saving the Results to a File

You can save most measurement results as statistics to a data log file.

NOTE. The application does not log results from the Overwrite or the Resolution

measurements.

Logging saves the statistical results from measurements to a data log file. To
access the Log Statistics menu, go to the Log menu in the menu bar and choose
Statistics.

Figure 2--19 shows the Log Statistics menu.

Figure 2- 19: Log Statistics menu

Clearing Results

Logging Statistics
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Table 2--15 lists the Log Statistics options with a brief description of each.

Table 2- 15: Log Statistics options

Option/button Description

Logging Enables the application to save the results to a data log file

Clear Deletes the data log file for the selected measurement; you must
disable the logging before you can clear the contents of the data log file

Save Current Stores the current measurement results in a “comma separated
variable” formatted file (.csv file) that you can view at a later time

Log file name:
Browse

Allows you to select the directory in which to save the data log file and
to enter a name for the file; the extension must be .csv

Figure 2--20 shows an example of the Log file directory that displays when you
select Browse.

Figure 2- 20: Log file directory

The data log file consists of one header row and rows of logged information. The
header row contains the application name, the version number of the application,
and the date and time on which the file was created. The remaining rows contain
information for the measurements. The information will vary with the measure-
ments being logged.

Data Log File Format
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NOTE. If you are using a GPIB program to execute the application, such as in

automated test environments, you can add your own annotation through the

logAnnotate GPIB command. You can add information consisting of up to 20

characters; the custom information will appear after the date and time in the

rows of logged data.

Viewing a Data Log File

You can view the .csv data log file (comma separated variable format) in a text
editing, spreadsheet, database, or data analysis program for further analysis.

NOTE. You can use Notepad or Wordpad to quickly view the results in the data

log file.

You must take measurements in Free Run mode to accumulate data points and
store them in one data log file. Figure 2--17 on page 2--17 shows an example of a
.csv file in a spreadsheet program.

Saving and Recalling Setups

You can use the Save/Recall Measurements menu to save and to recall different
configuration setups. To access the Save/Recall Measurements menu, go to the
Measurements menu in the menu bar and choose Save/Recall.

Figure 2--21 shows the Save/Recall Measurements menu.

Figure 2- 21: Save/Recall Measurements menu

Table 2--16 lists the Save/Recall Measurements options with a brief description
of each.
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Table 2- 16: Save/Recall Measurements options

Option/button Description

Save Allows you to select a file in which to save the application setup file

Recall Allows you to select a file from which to recall the application setup

Default Recalls the Default application setup values

File name for Save/Recall Displays the name of the last file used to save or recall a setup

NOTE. The Measurements > Save/Recall function includes the settings of the

oscilloscope application. When you exit the application, you can choose whether

to restore oscilloscope settings to those present before starting the application.

Do not edit the .ini or the .set files, or recall setup files not generated by the

application, since this can cause the application to become unstable.

To save the application settings to a setup file, follow these steps:

1. Select Measurements > Save/Recall.

2. Select the Save button. Figure 2--22 shows an example of how the directory
displays when you select the Save button.

Figure 2- 22: Save directory

3. Select the directory in which the setup file will be saved.

Saving a Setup
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4. Select or enter a file name. The application appends a .ini extension to the
name of setup files.

5. Choose Save.

NOTE. The application also saves the oscilloscope setup to a .set file when you

save an application setup. Both the application .ini file and oscilloscope .set file

have the same file name.

To recall the application settings from a saved setup file, follow these steps:

1. Select Measurements > Save/Recall.

2. Select the Recall button. Figure 2--22 shows an example of how directory
displays when you select the Recall button.

Figure 2- 23: Recall directory

3. Select the directory from which the setup file will be recalled.

4. Select or enter a setup file name.

5. Choose Recall.

NOTE. The application also recalls the oscilloscope setup from a .set file when

you recall an application setup.

Recalling a Saved Setup
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To recall the application settings from the Default setup file, follow these steps:

1. Select Measurements > Save/Recall.

2. Choose Default.

Exiting the Application

To exit the application, choose Exit. When you exit the application, you can
select to keep the oscilloscope setup currently in use with the application or to
restore the oscilloscope setup that was present before you started the application.
Figure 2--24 shows the Exit menu.

Restore oscilloscope
setup option

Figure 2- 24: Exit menu

Recalling the Default
Setup
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Tutorial

This tutorial teaches you how to set up the application, take a measurement,
view the results, and log the results. Further operating information is located in
the Operating Basics section.

Before you begin the tutorial, you must do the following tasks:

� Set up the oscilloscope

� Start the application

� Recall a waveform file

NOTE. Figures that show the display of an oscilloscope are from a TDS7104;

there may be minor differences if you work through this tutorial with another

type of oscilloscope.

Setting Up the Oscilloscope

To set up the oscilloscope, follow these steps:

1. Go to the File menu in the menu bar and select Recall Default Setup to set
the oscilloscope to the default factory settings.

2. Press the individual CH 1, CH 2, CH 3, and CH 4 buttons as needed to
remove active waveforms from the display.

Starting the Application

To perform these lessons, the application must be installed and enabled on the
oscilloscope. See Installation on page 1--5. To start the application, go to the File
menu in the oscilloscope menu bar and select Run Application> Disk Drive
Measurements. Figure 2--25 shows how the application starts up and displays.
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Figure 2- 25: Starting the application

Recalling a Waveform File

The application includes a TAA waveform that you can use with this tutorial.
The taapw50.wfm file is from a Read Signal.

To recall the taapw50.wfm file to Ref1 on to the oscilloscope, follow these steps:

1. Go to the File menu in the menu bar and access Reference Waveforms>
Reference Setup. Figure 2--26 shows the Ref tabs.

Figure 2- 26: Oscilloscope reference waveform setup

2. Select the Ref 1 tab and Recall. Choose the c:\TekApplications\tdsddm2\wa-
veforms directory. Figure 2--27 shows a list of waveform files that appear.
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Figure 2- 27: Waveform directory to recall reference waveforms

3. Select the taapw50.wfm file and Recall.

Taking a TAA Measurement

In this example, you will learn how to use the application to take a Track
Average Amplitude (TAA) measurement. To take a TAA measurement, refer to
Figure 2--28, and follow these steps:

1. To return to the application, choose the App button in the Menu bar.

2. Select Inputs> Input/Trigger> Input Channels> Read Signal> Ref 1.
Figure 2--28 shows the Input/Trigger menu setup.

Figure 2- 28: Inputs/Trigger menu setup
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3. Press to start the acquisition as shown in Figure 2--29.

Start button

Single mode

Figure 2- 29: Taking a measurement

Figure 2--30 shows the statistical results.

Figure 2- 30: TAA lesson: statistical results
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Saving the Results to a Data Log File

To save the measurement results to a data log file, follow these steps:

1. Go to the Log menu in the menu bar and select Statistics. Figure 2--31 shows
an example of the default application directory and log file name.

Figure 2- 31: Log Statistics menu with default file name

2. Select Logging On.

3. Press to start the acquisition.

4. Select Logging Off before viewing the data log file.

5. Exit the application.

Viewing a Data Log File

To view the data log file in a text editing application, such as Wordpad, follow
these steps:

1. From the tool bar, select Start icon> Programs> Accessories> Wordpad.

2. Select File> Open.

3. Locate the C:\TekApplications\tdsddm2\data directory.

4. Select All Documents (*.*) for the Files of Type.
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Figure 2- 32: Log file with default file name

5. Select the TAA.csv file and Open. Figure 2--33 shows the TAA.csv file
viewed in Wordpad.

Figure 2- 33: TAA.csv file viewed in Wordpad

You can also import the .csv file to a DOS-based personal computer and then
view the data log file with a spreadsheet, database, or data analysis program.
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Stopping the Tutorial

If you need more than one session to complete the tutorial lessons, you can stop
the tutorial and return to it another time.

To save the application setup and stop your session, refer to Saving a Setup on
page 2--22 and to Exiting the Application on page 2--24.

Returning to the Tutorial

To return to the tutorial setup, you can start the application and then recall the
saved setup. To recall the application setup, refer to Recalling a Saved Setup on
page 2--23.
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Application Examples

This section presents many application examples. The simplified examples
highlight the application measurements and give you ideas on how to use the
application to solve your own test problems.

� Measuring TAA

� Measuring PW50

� Measuring Asperity

� Measuring Overwrite

� Measuring Resolution

� Measuring Baseline Shift

� Measuring NLTS

� Measuring SNR

� Creating and viewing track profiles

To use these examples, you must have the TDSDDM2 application installed and
enabled on the oscilloscope, the probes connected to your disk drive system
under test (SUT), and the configuration tasks performed as needed for your SUT.
For information, see Installation on page 1--5 and Configuration on page 1--11.

To start the application, refer to page 2--25.

NOTE. Figures that show the display of an oscilloscope are from a TDS7104;

there may be minor differences if you are using another type of oscilloscope.

The application includes waveform files that you can recall to a reference
memory to try out each example in this section. Table 2--17 lists the waveform
file names.

Table 2- 17: Waveform files and application examples

File name Measurement File name Measurement

taapw50.wfm TAA and PW50 asperity.wfm Asperity

ovlosig.wfm Overwrite baselineShift.wfm Baseline Shift

ovhisig.wfm Overwrite x9x4x1.wfm NLTS and SNR
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Configuring a Measurement

You can configure any measurement to help you analyze measurement results.
The application includes the following possible configurations:

� Taking measurements from a range of sectors

� Adding a limit test

� Using cursors (gating)

� Specifying hysteresis to filter out noise

� Using filters to focus the application on specific parts of a waveform

To specify a range of sectors from which to take measurements, follow these
steps:

1. Select Inputs> Inputs/Trigger> Trigger Mode> Sector.

2. Select Start Sector> (number).

3. Select Stop Sector> (number).

4. Set the Preamble option. Use the multipurpose knob, and select a value that
is greater than the actual signal preamble duration. This ensures that the
preamble is not acquired and is not included in the measurement.

To use limit testing to include a pass/fail measurement result, follow these steps:

1. Select Limit Test On.

2. Use the multipurpose knob to set a value for the Upper Limit option that is
appropriate for your SUT.

3. Use the multipurpose knob to set a value for the Lower Limit option that is
appropriate for your SUT.

The Asperity measurement does not need to test limits.

Instead of measuring around the entire track, you can use cursor gating to
localize the measurement. To specify gating, follow these steps:

1. Select Inputs> General> Gating On.

2. In the oscilloscope program, position the cursors to bound the part (on either
side) of the waveform that you want to measure.

3. Select App to return to the application.

Specifying a Range of
Sectors

Specifying a Limit Test

Specifying Gating
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You can use the Hysteresis option to avoid identifying noise as actual signals.

To specify hysteresis, select Inputs/General> Hysteresis and use the multipurpose
knob to set a value for the Hysteresis option that is appropriate for your SUT.

The hysteresis value, in divisions, is reflected above and below the waveform
baseline. For example, if you choose a value of 1.5 divs, the hysteresis level
ranges from --1.5 divs to +1.5 divs.

You can modify the Read Signal input by applying filters that block specific
frequency bands. This removes information from the measurement that is not
useful to analyze. To use Filters, refer to page 2--10.

Using Reference Waveforms

To attain the results shown in each figure (except for Track Profile) from the
specified .wfm file, you need to define the following general setup:

1. In the oscilloscope menu bar, select File> Recall Default Setup.

2. Recall the appropriate .wfm file to one of the reference memories; refer to
page 2--26.

3. Select Measurements> Save/Recall> Recall default values.

4. Select the appropriate measurement from either the TAA/PW50 or NLTS/
Other Measurements menus.

5. Select the reference memory as the Read Signal input option in the Inputs/
Trigger menu.

Measuring TAA

In this example, you can measure the track average amplitude (TAA). To take a
TAA measurement, follow these steps:

1. Select Measurements> TAA/PW50> TAA.

2. To configure the measurement, refer to Configuring a Measurement on
page 2--34.

3. Set the Sequence Mode to Single or Free Run.

4. Select to start the measurement.

5. When the measurement is complete, the statistical results automatically
display. Figure 2--30 on page 2--28 shows an example of TAA measurement
results based on the taapw50.wfm file.

Specifying Hysteresis

Specifying a Filter



Application Examples

2- 36 TDSDDM2 Disk Drive Measurements Application User Manual

Measuring PW50

In this example, you can measure the pulse width at 50% (PW50). To take a
PW50 measurement, follow these steps:

1. Select Measurements> TAA/PW50> PW50.

2. To configure the measurement, refer to Configuring a Measurement on
page 2--34.

3. Set the Sequence Mode to Single or Free Run.

4. Select to start the measurement.

5. When the measurement is complete, the statistical results automatically
display. Figure 2--34 shows an example of PW50 measurement results based
on the taapw50.wfm file.

Figure 2- 34: PW50 measurement results example
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Measuring Asperity

In this example, the oscilloscope will detect asperities. To take an Asperity
measurement, follow these steps:

1. Select Measurements> NLTS/Other> Asperity.

2. Use the multipurpose knob to set a value for the Threshold option. The
recommended initial setting is at least twice the peak value of the signal. If
the signal crosses this level, it is counted as an asperity. No additional
asperities are counted until the signal crosses zero volts again.

3. If you want to change trigger settings or localize the measurement, do so
now. The application defaults to the settings specified in the Trigger menu.
For further information, see Setting Up the Application Trigger on
page 1--12.

4. Set the Sequence Mode to Single.

5. Select to start the measurement.

6. When the measurement is complete, a list of asperities, sector locations and
time locations automatically display. Figure 2--38 shows an example of the
results based on the asperity.wfm file with the Asperity Threshold as 1.5 V.

Figure 2- 35: Asperity measurement results example
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Measuring Overwrite

In this example, you can measure the overwrite amount of residual signal
remaining from a previous write when new data is written to the same location.
The application overwrites part of the disk drive to take this measurement.

To measure the overwrite, you will also need a personal computer.

NOTE. Select a record length on the oscilloscope of 5,000 or more for Overwrite

measurements. This increases the frequency and the measurement resolution.

To take an Overwrite measurement, follow these steps:

1. Erase the track by using a permanent magnet or using the PC to perform a
DC erase for many revolutions on a three band track of overlapping tracks
centered on the specified radius.

2. Write a low-frequency data pattern of isolated pulses to the track.

To try out this example, recall the ovlosig.wfm file to a reference memory.

3. Select Measurements> NLTS/Other> Overwrt.

4. Set the Sequence Mode to Single or Free Run.

5. Select to start the measurement. The application measures the magnitude
of the signal and then pauses.

The Sequence Control displays Paused For Action and the results display
PASS 1 in the upper right corner. Figure 2--36 shows an example of the
Overwrite measurement Pass 1 results based on the ovlosig.wfm file

6. Without erasing the previous data, overwrite the track with a high-frequency
data pattern.

If you are trying out this example, you can overwrite the ovlosig.wfm file
with the ovhisig.wfm file. To do this, recall the ovhisig.wfm file to the same
reference memory used for the ovlosig.wfm file.

7. Select to continue. The results display PASS 2 in the upper right corner.

When the measurement is complete, the statistical results automatically
display. Figure 2--37 shows an example of the Overwrite measurement
Pass 2 results based on the ovlosig.wfm and ovhisig.wfm files.
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Figure 2- 36: Overwrite measurement, PASS 1 example

Figure 2- 37: Overwrite measurement results, PASS 2 example
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Measuring Resolution

In this example, you can measure the resolution of a head and disk combination.
The application determines the ratio of two TAA measurements of a low-
frequency pattern to a high-frequency pattern. The result is a percentage.

To measure the resolution, you will also need a personal computer.

To take a Resolution measurement, follow these steps:

1. Erase the track by using a permanent magnet or using the PC to perform a
DC erase for many revolutions on a three band track of overlapping tracks
centered on the specified radius.

2. Use the PC to write a high-frequency data pattern of isolated pulses to the
disk.

3. Select Measurements> NLTS/Other> Resltn.

4. Set the Sequence Mode to Single.

5. Select to start the measurement. The oscilloscope performs a TAA
measurement of the high-frequency pattern and then pauses.

The Sequence Control displays Paused For Action and the results display
PASS 1 in the upper right corner.

6. Erase the track again as described in step 1.

7. Use the PC to write a low-frequency data pattern of isolated pulses to the
disk.

8. Select to continue. The results display PASS 2 in the upper right corner.

9. When the measurement is complete, the statistical results automatically
display.

An example is not included because it is similar to the Overwrite measurement.

Measuring Baseline Shift

In this example, you will measure the difference between the baseline of a
positive pulse and the baseline of a negative pulse. To take a Baseline Shift
measurement, follow these steps:

1. Select Measurements> NLTS/Other> Baseline Shift.

2. Set the Sequence Mode to Single or Free Run.

3. Select to start the measurement.
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4. When the measurement is complete, the statistical results automatically
display. Figure 2--38 shows an example of a Baseline Shift measurement
results based on the baselineShift.wfm file.

Figure 2- 38: Baseline Shift measurement results example

Measuring NLTS

To take NLTS measurements, your setup must meet the following requirements:

� The waveform selected for the measurement must correspond to a bit pattern
written on the disk generated using a valid (maximum length) polynomial;
among other things, this might require that you disable RLL encoding.

� The disk drive waveform must have at least 1,000 samples.

� There must be at least eight samples per bit.

� The oscilloscope must acquire at least three periods of the pattern where the
period is the amount of time before the pseudo-random bit pattern begins to
repeat itself; to do this depends on the sample rate of the oscilloscope, the
estimated value that you enter for the Pattern Dur option, and the number of
bits per period (based on the polynominal used).
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To take an NLTS measurement, follow these steps:

1. Select Measurements> NLTS/Other> NLTS Initial.

2. Select Pattern Dur and specify a value.

The pattern duration is the length of time of the period of a pseudo-random
data pattern in the readback signal. The pattern duration can be an estimate,
as long as the estimate is within the tolerance that you specify in step 3; the
application will measure the exact duration of the pattern. (Due to variations
in revolution speed between disk drives, specifying the pattern duration is
necessarily an estimate.)

3. Select Dur Toler and specify the tolerance of your pattern duration estimate
(up to 30%). Using a tighter tolerance reduces measurement time.

NOTE. If you know the exact duration of the data pattern, you can reduce the

measurement time by specifying a Duration Tolerance of 0%. The application

will use the Pattern Duration that you specify without attempting to adjust to the

actual duration of the pseudo-random pattern.

4. Select Poly Index and use the multipurpose knob to specify the pseudo-
random binary sequence polynomial. This should be the same polynomial
used to generate the data pattern written to the media.

For valid results, it is essential that you specify the same polynominial as the
one used for recording data on the hard disk (media). Both polynomials must
be valid according to the 1995 IDEMA “white paper.”

The NLTS measurement is based on autocorrelation and uses a polynomial
to generate a pseudo-noise sequence. Select the polynomial using the
multipurpose knob; all selections provide a valid pseudo-noise sequence.
(The application removes invalid polynomials from the selection set.) The
polynomial index value on the scale is a condensed notation of the selected
polynomial, obtainable by making x=2. For example:

Polynominal = x9
+ x4

+ 1

Polynominal index = 2
9
+ 2

4
+ 1 = 529

5. If you want to change trigger settings or localize the measurement, do so
now. The application defaults to the settings specified in the Trigger menu.
For further information, see Setting Up the Application Trigger on
page 1--12.

6. Set the Sequence Mode to Single or Free Run.

7. Press to start the acquisition.
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8. When the measurement is complete, the statistical results automatically
display. Figure 2--39 shows an example of NLTS Initial measurement results
based on the x9x4x1.wfm file.

Figure 2- 39: NLTS measurement results example

Measuring SNR

To take SNR measurements, your setup must meet the following requirements:

� The disk drive waveform must have at least 1,000 samples

� There must be at least eight samples per bit

� The oscilloscope must acquire at least three periods of the pattern where the
period is the amount of time before the pseudo-random bit pattern begins to
repeat itself; to do this depends on the sample rate of the oscilloscope, the
estimated value that you enter for the Pattern Dur option, and the number of
bits per period

To take an SNR measurement, follow these steps:

1. Select Measurements> NLTS/Other> SNR.

2. Select Pattern Dur and specify a value.
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The pattern duration is the length of time of the period of a pseudo-random
pattern in the readback signal. The pattern duration can be an estimate, as
long as the estimate is within the tolerance that you specify in step 3; the
application will measure the exact duration of the pattern. (Due to variations
in revolution speed between disk drives, specifying the pattern duration is
necessarily an estimate.)

3. Select Dur Toler and specify the tolerance of your pattern duration estimate
(up to 30%). Using a tighter tolerance reduces measurement time.

NOTE. If you know the exact duration of the data pattern, you can reduce the

measurement time by specifying a Duration Tolerance of 0%. The application

will use the Pattern Duration that you specify without attempting to adjust to the

actual duration of the pseudo-random pattern.

4. Select Bits/Pattern and specify a value.

Periodic signals used for the SNR measurement are isolated low-density
periodic transitions (low frequency), isolated high-density periodic transi-
tions (high frequency), or patterned data such as pseudo-random sequences.

� If you are using a high-frequency pattern consisting of constantly spaced
isolated transitions, use two bits per pattern for the low frequency and
high frequency patterns.

� For general patterned data, use the number of bits per pattern period,
depending on what was previously recorded on the disk.

� For pseudo-random data of pseudo-noise type generated with shift
registers (pseudo-random binary sequence), the number of bits per
pattern is 2L -- 1, where L is the order of the characteristic polynomial.
For example, for a 9th order polynomial the value would be 511 (29--1);
for a 7th order polynomial the value would be 127 (27--1).

5. If you want to change trigger settings or localize the measurement, do so
now. The application defaults to the settings specified in the Trigger menu.
For further information, see Setting Up the Application Trigger on
page 1--12.

6. Set the Sequence Mode to Single.

7. Press to start the acquisition.

8. When the measurement is complete, the statistical results automatically
display. Figure 2--40 shows an example of SNR measurement results based
on the x9x4x1.wfm file.
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Figure 2- 40: SNR measurement results example

Creating and Viewing Track Profile Plots

Track Profile plots are reference memory waveforms that contain a history of
measurement results. You can use track profiles to observe sector-to-sector
variations in measurements and to identify the location of flaws within a track.

NOTE. The result of creating a Track Profile plot from a reference waveform is a

short straight line.

To create and view a Track Profile plot, follow these steps:

1. Select a measurement from either the TAA/PW50 or NLTS/Other Measure-
ments menus.

2. To configure the measurement, refer to Configuring a Measurement on
page 2--34.

3. Select Inputs> General> Gating Off.

4. Select Plot> Track Profile> Store Profile In:> any reference memory.
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NOTE. As soon as you select Plot> Track Profile> On, the application deletes all

information contained in the selected reference memory.

5. Select Plot> Track Profile> On.

6. Set the Sequence Mode to Single or Free Run.

7. Select to start the measurement. The measurement results are saved as
statistics and are stored as a track profile plot in the reference memory
selected in step 4.

Figure 2--41 shows an example of a Track Profile plot from a TAA measure-
ment.

Figure 2- 41: Track Profile plot example

8. If you use the Sector Trigger mode, you can also use the vertical cursors on
the oscilloscope. To use the vertical cursors, press the Cursors front-panel
button. The default Cursor Type is V Bars.

9. Select App to return to the application. Figure 2--42 shows an example of a
Track Profile plot with vertical cursors.
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You can view the results of each execution of the measurement algorithm by
moving the cursor along the Track Profile plot. The Value at Cursor and Sector at
Cursor readouts show the measurement results at the current location of the
cursor. The Value at Cursor readout is in units relative to the measurement ( such
as V, MHz, dBs).

NOTE. The readout values are only available with the current Track Profile plot;

they are not available with waveforms that are recalled as a reference memory.

You also must select the Sector Trigger mode to use cursors with Track Profiles.

Figure 2- 42: Track Profile plot with cursors

10. To save the reference waveform containing the plot, follow these steps:

a. Go to the File menu in the menu bar of the oscilloscope and access
Reference Waveforms> Reference Setup.

b. Select the appropriate Ref tab and Save Wfm to File.

11. To clear the Track Profile plot, select Reset.
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GPIB Program Example

This section contains an example of a GPIB program that can execute the
TDSDDM2 application. The oscilloscope hard disk and the optional applications
compact disc both contain this program in the ddm2ctrl.c file. The file resides on
the hard drive in the C:\Program Files\TekApplications\tdsddm2 directory.

Guidelines

Your GPIB program should comply with the following guidelines:

� The application startup must complete before sending additional GPIB
commands to the application (see example).

� The measurements cycle must complete before data is queried (see example).

� The error variable should be checked to ensure that an error has not occurred
because of a measurement command problem.

Program Example

This example shows how a GPIB program might execute the application to do
the following tasks:

� Start the application

� Select a measurement

� Select an input

� Define a waveform

� Enable the logger

� Take a measurement

� Check for an error

� Exit the application

Refer to Appendix B: GPIB Command Syntax for a complete list of the GPIB
command syntax with the arguments, variables, and variable values.

NOTE. GPIB commands are case and space sensitive.
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/* C Program Example: TDSDDM2 GPIB control */
/* ====================================================================
* This sample program is for Tektronix Java application TDSDDM2 --
* Disk Drive Measurements
*
* Note1: In order to build the .exe correctly, copy gpib-32.obj from
* ”C:\Program Files\National Instruments\GPIB\NI488\LangInt\C\” or
* ”C:\Program Files\GPIB-NT\LangInt\C\ to
* the workspace.
*
*/

#include <string.h>
#include <stdio.h>
#include <sys/timeb.h>
#include <windows.h>
#include ”C:\GPIB-NT\LangInt\C\decl-32.h”

int start_application(/* in */ int scope);
int do_single_test(/* in */ int scope);

void main (void)
{

char read_buffer [100] = ””;
char write_buffer [100] = ””;
int scope;
int status;

/*
* Open session for IBIC
*/
scope = ibfind (”DEV2”);
status = ibpad (scope, 1);
status = ibtmo (scope, T10s);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*
* Start Application
*/
if (start_application(scope)){

printf (”Application is started up!\n”);

/*
* Turn on a measurement (TAA)
*/
sprintf (write_buffer, ”%s”, ”Variable:value \”measurement\”,\”TAA\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));
/*
* Select Source Type -- REF
*/
sprintf (write_buffer, ”%s”, ”Variable:value \”readSignal\”, \”Ref1\””);
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status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*
* Recall Waveform to Ref
*/
sprintf (write_buffer, ”%s”, ”recall:waveform
\”c:\\TekApplications\\tdsddm2\\waveforms\\diskdrive.wfm\”, REF1”);

status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*
* Display Ref1
*/
sprintf (write_buffer, ”%s”, ”select:ref1 on”);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*
* Turn on Log Statistics for TAA measurement
*/
sprintf (write_buffer, ”%s”, ”Variable:value \”TAAloggerState\”,\”On\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));
/*A Timer is needed after setting the loggerState on*/

Sleep(2000);

/*
* Do a single test
*/

if (do_single_test(scope)){

/*
* Set Measurement for which you want to query test result -- TAA
*/
sprintf (write_buffer, ”%s”, ”Variable:value \”resultFor\”, \”TAA\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*A Timer is needed after setting the measurement to be queried*/
Sleep(500);
/*
* Query mean result
*/
sprintf (write_buffer, ”%s”, ”Variable:value? \”mean\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));
status = ibrd (scope, read_buffer, sizeof (read_buffer));

if (ibcnt != 3) { /* It’s not an empty string */
read_buffer [ibcnt] = 0; /* Get rid of extra characters */
printf (”Mean TAA = ”);
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printf (”%s”, read_buffer);
}

}
else

printf (”*** Fail to query result ***\n”);

}
else{

printf (”*** Fail to start Application ***\n”);
return;

}

/*
* Display Off for Ref1 before exiting
*/
sprintf (write_buffer, ”%s”, ”select:ref1 off”);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*
* Exit application
*/
printf (”Exit application!\n”);
sprintf (write_buffer, ”%s”, ”Variable:value \”application\”,\”exit\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

/*
* Program Ending
*/
printf (”Program Terminating Normally\n\n”);

return;

}

/*--------------------------------------------------------------------------
* Function: start_application
* Argument: scope
* Return: 1 if success, 0 otherwise
*
* This function starts the application and comfirms the completion of startup
*/
int start_application(/* in */ int scope)
{

char read_buffer [100];
char write_buffer [100];
char app_name[30] = ”\”tdsddm2\”\n”;
int status;
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int timer = 0;
int i = 0;

/*
* Has application already been started?
*/
sprintf (write_buffer, ”%s”, ”Variable:value? \”application\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));
status = ibrd (scope, read_buffer, sizeof (read_buffer));
read_buffer [ibcnt] = 0; /* Get rid of extra characters */

if (strcmp(app_name, read_buffer) == 0){
return 1; /* Application is running, don’t need to do anything */

}

/*
* If application is not started up, start it and wait for application to completely
* start up
*/

sprintf (write_buffer, ”%s”, ”Application:activate \”Disk Drive Measurements V2\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

printf (”Starting application, please wait...\n”);
while (strcmp(app_name, read_buffer) != 0){

timer = timer + 2;
if (timer > 45) { /* The application normally take 24 seconds to start up */

printf (”***Application start up time out***\n”);
return 0; /* Something is wrong if application does not start up in 30s */

}
sprintf (write_buffer, ”%s”, ”Variable:value? \”application\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));
status = ibrd (scope, read_buffer, sizeof (read_buffer));
read_buffer [ibcnt] = 0;/* Get rid of extra characters */

Sleep(2000);

}
/* Application start up! */

return 1;
}

/*--------------------------------------------------------------------------
* Function: do_single_test
* Argument: scope
* Return: 1 if success, 0 otherwise
*
* This function does a single measurement
*/
int do_single_test(/* in */ int scope)
{
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char read_buffer [100];
char write_buffer [100];
char state[10] = ”\”Ready\”\n”;
int status;
int timer = 0;
int i = 0;

/*
* Start measurement
*/

printf (”Do a single test...\n”);
sprintf (write_buffer, ”%s”, ”Variable:value \”sequencerState\”,\”Sequencing\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));

do{
timer = timer + 2;
if (timer > 60) {/* Assuming a single test takes less than 60 seconds */

printf (”***Test time out***\n”);
return 0; /* Something is wrong if sequencerState does not come back

* to Ready */
}
sprintf (write_buffer, ”%s”, ”Variable:value? \”sequencerState\””);
status = ibwrt (scope, write_buffer, strlen (write_buffer));
status = ibrd (scope, read_buffer, sizeof (read_buffer));
read_buffer [ibcnt] = 0;/* Get rid of extra characters */

Sleep(2000);
}while (strcmp(state, read_buffer) != 0);

return 1;
}



Reference
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Menu Structure

Figure 3--1 shows the relationship of the application-specific menus.

Measurements

TAA/PW50
NLTS/other
Save/Recall
Minimize

TAA
TAA+
TAA--
TAA Snap shot
PW50
PW50+
PW50--
PW50 Snap shot

NLTS Initial
NLTS 1st Adj
NLTS 2nd Adj
NLTS Snap shot
SNR
Asperity
Overwrite
Resolution
Baseline Shift

Limit Test

NLTS Parameters
Pattern Duration
Duration Tolerance
Polynomial Index

Pattern Duration
Duration Tolerance
Bits per pattern

Threshold

On/Off
Upper Limit
Lower Limit

Limit Test

On/Off
Upper Limit
Lower Limit

SNR Parameters

Asperity Parameter
Save
Recall
Default File name [Browse]

Inputs/Trigger
Filter
General

Read Signal
Sector Pulse
Read Gate
Index Pulse

Inputs

Mode
Start Sector
Stop Sector
Preamble Duration

Hysteresis
Gating

On/Off
Store Profile In
Value at Cursor*
Sector at Cursor*
Reset

Track ProfilePlot

Sector
Read Gate
User
Index

*Displays numeric values only

View Results

Filter1
Filter 2

Cutoff Freq
Update
Type
Slope
Store In

Figure 3- 1: Menu structure
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Figure 3--2 shows the structure of the Log, Help, and Sequence Control menus.

Help

Sequence Control

Sequence Mode
Start/Continue
Pause
Stop
Reset

Contents and Index
About TDSDDM2

Single Acq
Free Run

Log Staistics

Log
Clear
Save Current
Log File Name [Browse]

Log

Figure 3- 2: Menu structure (continued)
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Parameters

This section describes the TDSDDM2 application parameters. You should refer
to the user manual for your oscilloscope for operating details of other controls,
such as front-panel buttons.

Refer to Appendix D: GPIB Command Syntax for a complete list of the GPIB
command syntax with the arguments, variables and variable values that
correspond to the TDSDDM2 parameters.

NOTE. Incremental unit values shown are valid when the FINE button is enabled

on the oscilloscope.

Measurements Menu

There are four Measurements menu items: TAA/PW50, NLTS/Other, Save/Re-
call, and Minimize.

The options in the TAA/PW50 Measurements menu are:

� TAA, default

� TAA+

� TAA--

� TAA Snapshot

� PW50

� PW50+

� PW50--

� PW50 snapshot

Table 3--1 lists the parameters for the Limit Test area for each measurement and
the selections or range of values available for each.

TAA/PW50 Menu
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Table 3- 1: TAA/PW50 Limit Test area parameters

Measurement Option Selections Default setting

All On/Off On, Off On

TAA, TAA+, TAA Snapshot Upper Limit

Lower Limit

0 Vpp to 10.0 Vpp in units of 1 mVpp

0 Vpp to 10.0 Vpp in units of 1 mVpp

10.0 Vpp

0.0 Vpp

TAA-- Upper Limit

Lower Limit

--10.0 Vpp to 0 Vpp in units of 1 mVpp

--10.0 Vpp to 0 Vpp in units of 1 mVpp

0.0 Vpp

--10.0 Vpp

PW50, PW50+, PW50--,
PW50 Snapshot

Upper Limit

Lower Limit

0 s to 1.0 s in units of 50 ps

0 s to 1.0 s in units of 50 ps

1.0 s

0 s

The options in the NLTS/Other Measurements menu are:

� NLTS Initial

� NLTS 1st Adj

� NLTS 2nd Adj

� NLTS Snapshot

� SNR

� Asperity

� Overwrite

� Resolution

� Baseline shift

Table 3--2 lists the parameters for the Limit Test area for each measurement and
the selections or range of values available for each.

Table 3- 2: NLTS/Other Limit Test area parameters

Measurement Option Selections Default setting

All* On/Off On, Off On

NLTS Initial, NLTS 1st Adj,
NLTS 2nd Adj, NLTS
Snapshot

Upper Limit

Lower Limit

--100% to 100% in units of 0.1%

--100% to 100% in units of 0.1%

100%

--100%

NLTS/Other Menu
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Table 3- 2: NLTS/Other Limit Test area parameters (Cont.)

Measurement Default settingSelectionsOption

SNR Upper Limit

Lower Limit

--20.0 dB to 100 dB in units of 0.1 dB

--20.0 dB to 100 dB in units of 0.1 dB

100.0 dB

--20.0 dB

Baseline Shift Upper Limit

Lower Limit

--5.0 Vpp to 10.0 Vpp in units of 1 mVpp

--5.0 Vpp to 10.0 Vpp in units of 1 mVpp

10.0 Vpp

0.0 Vpp

Overwrt Upper Limit

Lower Limit

0 dB to 100 dB in units of 0.01 dB

0 dB to 100 dB in units of 0.01 dB

100.0 dB

0.0 dB

Resltn Upper Limit

Lower Limit

0.1% to 200% in units of 0.1%

0.1% to 200% in units of 0.1%

200%

100m%

*There is no Limit Test area for the Asperity measurement.

Table 3--3 lists the NLTS Parameters area and the selections or range of values
available for each.

Table 3- 3: NLTS Parameters area

Option Selections Default setting

Pattern Dur 1.0 ns to 1.0 ms in units of 1.0 ns 9.922 �s

Dur Toler 0% to 30% in units of 1% 5%

Poly Index 19 to 4073 529

Table 3--4 lists the SNR Parameters area and the selections or range of values
available for each.

Table 3- 4: SNR Parameters area

Option Selections Default setting

Patten Dur 1.0 ns to 1.0 ms in units of 1.0 ns 9.922 �s

Dur Toler 0% to 30% in units of %1 5%

Bits/Pattern 1 to 8191 511
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Table 3--5 lists the Asperity Parameter area and the range of values.

Table 3- 5: Asperity Parameter area

Option Selections Default setting

Threshold 0.0 V to 10.0 V in units of 10 mV 2.0 V

Table 3--6 lists the parameters for the Save/Recall Measurements menu and the
selections available for each.

Table 3- 6: Save/Recall Measurements menu parameters

Option Selections Default setting

Save None C:\TekApplications\tdsddm2\setups\setup1.ini

Recall None C:\TekApplications\tdsddm2\setups\setup1.ini

Default None

There are no parameters for the Minimize function.

Inputs Menu

There are three Inputs menus: Inputs/Trigger, Inputs Filter, and Inputs General.

Table 3--7 lists the parameters for the Input Channels area and the selections or
range of values available for each.

Table 3- 7: Input Channels area parameters

Option Selections Default setting

Read Signal Ch 1, Ch 2, Ch 3, Ch 4, Ref 1, Ref 2, Ref 3, Ref 4,
Math1, Math 2, Math 3, Math 4

Ch 1

Read Gate Ch 1, Ch 2, Ch 3, Ch 4 Ch 2

Sector Pulse Ch 1, Ch 2, Ch 3, Ch 4 Ch 3

Index Pulse Ch 1, Ch 2, Ch 3, Ch 4 Ch 4

Table 3--8 lists the parameters for the Trigger area and the selections or range of
values available for each.

Save/Recall Menu

Minimize Menu

Inputs/Trigger Menu
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Table 3- 8: Trigger area parameters

Option Selections Default setting

Mode Sector, Read Gate*, User*, Index* User

Preamble** 0 s to 250.0 s in units of 1.0 ns 1.0 �s

Start Sector** 1 to 1000 in units of 1 sector 1

Stop Sector** 1 to 1000 in units of 1 sector 1

* Refer to Setting up the Oscilloscope Trigger on page 1- 11.

** Only available when Sector is the trigger mode.

Table 3--9 lists the parameters for the Filter 1 and Filter 2 areas and the selections
or range of values available for each.

Table 3- 9: Filter 1 and Filter 2 areas parameters

Option Selections Default setting

On/Off On, Off Off

Cutoff Freq 5% to 35% of the Sample Rate

Update None

Type Lowpass, Highpass Lowpass, Filter 1
Highpass, Filter 2

Slope 12 dB/oct to 84 dB/oct in units of 12 dB/oct 24 dB/oct

Store In None, Ref 1, Ref 2, Ref 3, Ref 4 Filter 1 in Ref 3
Filter 2 in Ref 4

NOTE. The Update command button changes the Cutoff Freq value if you change

the Sample Rate on the oscilloscope.

Table 3--10 lists the parameters for the Inputs General menu and the selections or
range of values available for each.

Table 3- 10: General menu parameters

Option Selections Default setting

Hysteresis 0.1 divs to 5.0 divs in units of 0.1 divs 0.8 divs

Gating On, Off Off

Inputs Filters Menu

Inputs General Menu
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View Menu

There are no parameters for the View Results menu.

Plot Track Profile Menu

Table 3--11 lists the parameters for the Plot Track Profile menu, and the
selections or range of values available for each.

Table 3- 11: Plot Track Profile menu parameters

Option Selections Default setting

On/Off On, Off Off

Store Profile In: Ref1, Ref2, Ref3, Ref4 Ref1

Reset None

Log Statistics Menu

Table 3--12 lists the parameters for the Log Statistics menu and the selections or
range of values available for each.

Table 3- 12: Log Statistics menu parameters

Option Selections Default setting

Logging On, Off Off

Clear None

Save Current None

Log File Name:
Browse

Any file C:\TekApplications\tdsddm2\data\<measurement>.csv

Help Menu

There are no parameters for the Help menu.
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Sequence Control Menu

Table 3--13 lists the parameters in the Sequence Control menu and the selections
available.

Table 3- 13: Sequence Control menu parameters

Parameter Selections Default setting

Mode Single, Free Run Single

Start (or Continue) None

Pause None

Stop None

Reset None
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Appendix A: Measurement Algorithms

The TDSDDM2 application takes disk drive measurements. This appendix
contains information about the algorithm used by the application to perform each
measurement

Unless specifically stated otherwise, all measurements in the Disk Drive
Measurements Application are conducted in accordance with procedures
specified in the International Disk Drive Equipment and Materials Association

(IDEMA) Disk Drive Standard.

NOTE. Refer to the Applications Examples section for information on how to

perform each measurement. Each example includes a detailed procedure.

Oscilloscope Setup Guidelines

For all measurements, use the following guidelines to set up the oscilloscope:

1. The signal is any channel, reference, or math waveform.

2. The vertical scale for the waveform must be set so that the waveform does
not exceed the vertical range of the TDS oscilloscope.

3. The time per division must be set small enough to capture sufficient
waveform detail and avoid aliasing.

4. Use a differential probe on the Read channel signal to reject noise and
remove DC bias.

TAA Measurements

The Track Average Amplitude is the average peak-to-peak value of the data on
the Read Signal input over the specified range of sectors.

IDEMA specifies the measurement to be over one complete track revolution.
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The application calculates this measurement using the following equation:

TAA =
1
N

N–1

Σ
i = 0

Vpp(i)

Where: N is the number of positive and negative pulse pairs

Vpp is the peak-to-peak voltage

The application performs the measurement according to the following algorithm:

1. Find all of the peak-to-trough pairs in the data area to be measured.

Find the peak by searching from the first crossing of the signal above the
positive hysteresis level to the crossing of the signal below the negative
hysteresis level. (See Figure A--1.) Keep the maximum value over this range.
Take one sample on either side of the maximum value and average the three
values to obtain the positive peak value. This is done to remove noise bias
which would otherwise occur.

2. Search the range from the negative hysteresis crossing to the next positive
hysteresis crossing; keep the minimum value. Take one sample on either side
of the minimum value and average the three values to obtain the negative
peak value.

3. Average all measured peak-to-peak values. The result is the TAA value.

Figure A--1 shows how a TAA measurement is defined.

Peak

Trough

TAA

Figure A- 1: TAA measurement
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The TAA+ measurement is the average positive peak value of the data on the
Read Signal input over the specified range of sectors. The TAA--measurement is
the average negative peak value of the data on the Read Signal input over the
specified range of sectors.

The application calculates these measurements using the following equation:

TAA �=
1
N

N–1

Σ
i = 0

V
p
(i)

Where: N is the number of positive or negative pulses

Vp is the peak (positive or negative) voltage

The baseline reference for measuring TAA+ or TAA-- is zero volts.

The application performs the measurement according to the same algorithm used
in the TAA measurement, described on page A--2, except only positive pulses
are measured for TAA+ and only negative pulses are measured for TAA--.

Figure A--2 shows how TAA+ and TAA-- measurements are defined.

Peak

Trough

TAA

TAA--

TAA+

OV

Figure A- 2: TAA+ and TAA- measurements

PW50 Measurements

The PW50 measurement is the average pulse width at 50% of the pulse peak of a
group of both positive and negative pulses. Peaks and troughs are measured. The
baseline reference for measuring the peak or trough is zero volts.

TAA+ and TAA-
Measurements
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Figure A--3 shows how a pulse width at 50% is defined.

50%

50%

PW

Figure A- 3: Pulse width at 50%

The application calculates this measurement using the following equation:

PW =
1
N

N–1

Σ
i = 0

PW(i)

Where: N is the number of positive and negative pulse pairs

PW is the pulse width at 50%

The application performs the measurement according to the following algorithm:

1. Set the disk drive to the specified speed.

2. Position the head to the desired gap, radius, and skew angle.

3. Precondition the media service. (See the IDEMA standard, document T3-91,
for information about preconditioning the media service.)

4. Write the specified frequency at the specified current for one revolution of
the disk.

5. Measure the peak-to-peak analog amplitude of the Read Signal for one entire
revolution, excluding all nonuniform segments, such as write splices, servo
gaps, and header fields. Uses the hysteresis value when looking for peaks.

6. Compute the track average amplitude around the entire track by summing up
the peak-to-peak voltages of each plus and minus pulse pair. Divide the
result by the number of pulse pairs.
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7. Perform the measurement by acquiring one segment at a time, measuring it,
and combining all the results for the final value. To speed up the measure-
ment process, you can specify a smaller region of each track segment to
measure by using the cursors gating or by decreasing the record length.

This measurement requires you to specify the number of segments on the
track to be tested.

8. Use a value of 1/2 of the TAA value as the threshold level at which to
measure the pulse width of each positive and negative pulse. Compute the
average pulse width around the track for all pulses measured.

9. Displays the results in the View Results menu, saves the results as a Track
Profile plot in a reference memory, or logs the data to a file. (The results also
display the standard deviation of the measurement for all pairs used.)

The pulses making up the tested group are selected by the following criteria:

� There must be enough pulses around the recording track to provide an
adequate statistical sample.

� The spacing between pulses must minimize any interaction between the
measured pulses.

Figure A--4 shows how PW50 measurements are defined.

Peak

Trough

1/2 peak to baseline

Baseline

PW50+

PW50 --

0 V

Figure A- 4: PW50 measurements

The PW50+ measurement is the pulse width at 50% of the peak value of the
pulse; only peaks are measured. The PW50-- measurement is the pulse width at
50% of the trough value of the pulse; only troughs are measured.

The application performs the measurement according to the same algorithm used
in the PW50 measurement, described on page A--3, except only positive pulses
are measured for PW50+ and only negative pulses are measured for PW50--.

PW50+ and PW50-
Measurements
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NLTS Measurements

The NLTS measurement calculates three types of nonlinear transition shift on the
disk drive media as follows:

� Initial magnetization (DC erased)

� First adjacent transition

� Second adjacent transition

The initial magnetization of the media can affect the position at which transitions
(reverses in magnetization) are recorded. Initial magnetization is characterized by
a delay in a transition, occurring when the new transition reverses the direction
of the previous magnetization.

The second transition in a series of consecutive transitions is called the first
adjacent transition. The first adjacent transition is characterized as follows: when
write data requires transitions on consecutive data bits, the latter transition is
shifted earlier in time. In other words, when one transition in a series occurs,
then the following transition occurs earlier than it should.

All subsequent transitions in the series of consecutive transitions are grouped
into the category called second adjacent transition. Second adjacent transitions
are similar to first adjacent transitions. The difference is that the transitions are
separated by two bit periods, not one.

When nonlinear transition shift can be characterized, its behavior can be
mitigated with write pre-compensation.

There is no NLTS specification in the IDEMA standard. The NLTS measurement
is based on a time domain cross-correlation method detailed in the IDEMA Test
and Measurement Committee PRML Working Group Working Paper Nonlinear
Distortion Measurement Techniques, September 1995.

The NLTS measurement algorithm assumes that the acquired signal consists of a
periodic signal and independent additive noise. The noise is assumed to be
responsible for all the nonperiodic behavior of the acquired waveform.

The application performs the measurement according to the following algorithm:

1. Acquire three or more cycles of the pseudo-random pattern sequence read
from the disk drive.

2. You specify the polynomial used to generate the waveform, the approximate
duration of one period of the periodic signal captured in the waveform, and
the tolerance of the approximation.

Test Methodology
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NOTE. The specified polynomial must generate a pseudo-noise (maximum length)

sequence, or the measurement will not proceed.

3. (This step is not performed if you specify a Duration Tolerance of 0%.)
Compute the actual cycle time and delay values. Cycle time is the period of
time required for the pseudo-random pattern until it begins to repeats itself.

NLTS guarantees that the real cycle time is determined by the measurement
if your initial estimate for the cycle time is within the specified tolerance (up
to 30%) of its real value.

The NLTS measurement uses several cycles of the pseudo-random pattern
waveform to improve the accuracy of the measurement, averaging over
multiple single-waveform-cycle NLTS values.

The NLTS initial magnetization measurement assumes the following sequence:

1. The medium is initially magnetized in one direction (DC-erased)

2. Transitions that are written by a head field in the opposite direction are
shifted later by an amount ε0.

The application calculates this measurement using the following equation:

V
~
(t) ≈ V�t – 1

2
ε0
� – 1

2

ε0

T
V�t – 1

2
ε0 + �M0 –

1

2
�T�

Where: V
~
(t) is the playback voltage for a readback channel affected by

NLTS initial magnetization

V(t) is the playback voltage in the absence of nonlinear effects

T is the bit period

ε0 is the amount of shift

M0 is an integer, whose unique value is determined by the
polynomial used to generate the recorded pseudo-noise bit
sequence

The measurement reports the nonlinear effect as a percentage of T; that is,
ε0

T
.

The NLTS first adjacent transition is the condition where the location of a
transition is shifted earlier by an amount ε1 due to another transition one bit
interval earlier.

NLTS Initial Measurement

NLTS 1st Adjacent
Measurement
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The application calculates this measurement using the following equation:

V
~
(t) ≈ V�t+ 1

2
ε1
�+ 1

2

ε1

T
V�t+ 1

2
ε1 –

3

2
T� – 1

2

ε1

T
V�t+ 1

2
ε1 + �M1 –

1

2
�T�

Where: V
~
(t) is the playback voltage for a readback channel affected by

NLTS first adjacent transition

V(t) is the playback voltage in the absence of nonlinear effects

T is the bit period

ε1 is the amount of shift

M1 is an integer, whose unique value is determined by the
polynomial used to generate the recorded pseudo-noise bit
sequence

The NLTS second adjacent transition is similar to the NLTS first adjacent
transition, with the exception that there are two bit intervals between the
transitions. The amount of shift in this case is ε2. The direction of the shift is
determined by the direction of the transitions (earlier if the transitions are
opposite, and later if the transitions are in the same direction).

The application calculates this measurement using the following equation:

V
~
(t) ≈ V(t) – 1

2

ε2

T
V�t – 3

2
T�+ 1

2

ε2

T
V�t – 5

2
T�+ 1

2

ε2

T
V�t+ �M1 –

1

2
�T� – 1

2

ε2

T
V�t+ �M2 –

1

2
�T�

Where: V
~
(t) is the playback voltage for a readback channel affected by

NLTS second adjacent transition

V(t) is the playback voltage in the absence of nonlinear effects

T is the bit period

ε2 is the amount of shift

M1 and M2 are integers, whose unique values are determined by
the polynomial used to generate the recorded pseudo-noise bit
sequence

The measurement reports the nonlinear effect as a percentage of T; that is,
ε2

T
.

NLTS 2nd Adjacent
Measurement
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Other Measurements

The Signal-to-Noise Ratio (SNR), Asperity, Overwrite, Resolution, and Baseline
Shift measurements perform other specialized operations.

The SNR measurement determines the ratio of the variance of the readback
signal to readback noise. The measured noise consists of media noise, crosstalk,
electronic noise, and other noise types characteristic to disk drives. Electronic
readback noise effects can be mitigated by the averaging operation performed by
the SNR measurement.

Signal-to-noise ratio is defined in terms of variances of the signal and noise, and
thus is independent of DC offsets of the readback voltage. The SNR measure-
ment algorithm assumes that the acquired signal consists of a periodic signal and
independent additive noise. The noise is assumed to be responsible for all the
nonperiodic behavior of the acquired waveform. Noise samples are assumed to
be independent and identically distributed.

The application calculates this measurement using the following equation:

SNR = 10 log10
�σ2

s

σ
2

n

�

Where: σ
2

s
is the variance of the noise-free periodic signal

σ
2

n
is the variance of the noise

The application performs the measurement according to the following algorithm:

1. Acquire three or more cycles of the waveform.

2. The user specifies the number of bits in the data pattern and the duration of
the pattern, within a known tolerance.

3. (This step is not performed if the user specifies a Duration Tolerance of 0%.)
Compute the actual cycle time and delay values. SNR guarantees that the
real cycle time is determined by the measurement if the initial user estimate
for the cycle time is within the specified tolerance (up to 30%) of its real
value.

The SNR measurement uses several cycles of the waveform to improve the
accuracy of the measurement, averaging over multiple single-waveform
cycle SNR values.

The Asperity measurement determines whether the head has hit a flaw in the
media surface (a thermal asperity has occurred). When the head hits the surface
of the media, a large voltage spike results.

SNR Measurement

Asperity Measurement
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The application performs the measurement according to the following algorithm:

1. You enter a threshold value to specify what is considered an asperity. the
threshold needs to be set to a level greater than TAA.

2. Begin testing for asperities, checking each peak/trough pair against the
specified threshold. If the TAA for a peak/trough pair exceeds the threshold,
report an asperity.

3. Display the results: the sector number where the asperity occurred and the
time relative to the start of the acquired data record.

The Overwrite measurement determines the amount of residual signal remaining
from a previous write after new data is written to the same location. The strength
of the residual signal depends on the coercivity of the media, write current
amplitude, and saturation characteristics of the head.

The application calculates this measurement using the following equation:

Overwrite(dB) = 20 log �Vr

Vo

�

Where: Vr is the residual RMS amplitude

Vo is the RMS amplitude

The application performs the measurement according to the following algorithm:

1. Erase the test track.

2. Write data for one revolution at a low rate f1.

3. Measure the RMS amplitude (Vo) through a narrow band filter tuned to f1.

4. Overwrite the track with data at a high frequency f2.

5. Measure residual RMS amplitude (Vr) at f1 again.

6. Calculate the results.

7. Display the results.

The Resolution measurement is a ratio of two TAA measurements: a low-fre-
quency pattern to a high-frequency pattern.

The result is expressed as a percentage. You can use this measurement to infer
the raw write density of the disk.

Overwrite Measurement

Resolution Measurement
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The application calculates this measurement using the following equation:

Resolution =
TAA(f2)

TAA(f1)
* 100%

Where: f1 is the low-frequency TAA measurement

f2 is the high-frequency TAA measurement

The application performs the measurement according to the following algorithm:

1. Erase the test track.

2. Write data for one revolution at a high frequency f2.

3. Measure the TAA over the selected range of sectors.

4. Erase the test track.

5. Write the track with data at a low frequency f1.

6. Measure the TAA over the selected range of sectors.

7. Calculate the ratio of the high-frequency TAA to the low-frequency TAA.

8. Display the results.

The Baseline Shift measurement is the difference between the baseline of the
positive pulse and the baseline of the negative pulse.

The application calculates this measurement using the following equation:

Baseline Shift =
100 (v1− v2)

Vpp%

Where: v1 is the baseline of the positive pulse

v2 is the baseline of the negative pulse

The application performs the measurement according to the following algorithm:

1. Measure the time position of a positive peak.

2. Measure the time position of the following negative peak and the following
positive peak.

3. Use the peak-to-peak value (Vpp) of the Read signal and calculate the
difference between the two baselines.

Baseline Shift
Measurement
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4. Display the results.

Snapshot Measurements

To see the summary measurements available for TAA, PW50, or NLTS, you can
use the snapshot version of these measurements. Figure A--5 shows snapshot
measurement data for the different measurements.

Figure A- 5: Snapshot measurement data

Snapshots can take the following measurements:

� Amplitude asymmetry

� Time asymmetry
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� Time peak-to-trough

� Time trough-to-peak

The Amplitude Asymmetry measurement uses TAA values to compare the
symmetry of the positive and negative pulses. It is available only in the TAA
snapshot display.

A zero value for amplitude asymmetry indicates that the signal is totally
symmetric. A non--zero value indicates the percent of asymmetry of the signal.
The range is from --100% to 100%.

The application calculates this measurement using the following equation:

Amplitude asym = 100� |TAA+ | – |TAA–|

Peak
�

Where: TAA+ is the mean of the calculated TAA+ measurement, as
defined on page A--2

TAA-- is the mean of the calculated TAA-- measurement, as
defined on page A--2

Peak Value is the larger of the absolute value of TAA+ or
the absolute value of TAA--

The Time Asymmetry measurement measures the ability of the head and the
media combination to process positive and negative transitions identically. The
time asymmetry measurement is based on timing between pulse peaks. It is
available only in the PW50 snapshot display.

The application calculates this measurement using the following equation:

Time asym =
1
4N
�

(i= 1...N)

( | T1 – T2
| )

Where: i indexes negative pulses

N is the number of measured time intervals

T1 is the time from the prior positive pulse to the current pulse

T2 is the time from the current pulse to the next positive pulse

These measurements operate as other measurements in the sense that a range of
sectors is defined, and the measurement average and standard deviation

Amplitude Asymmetry
(Amplitude asym)

Time Asymmetry
(Time asym)
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calculated. The range of the measurement within each sector is determined by the
cursors.

The time peak-to-trough (Time PT) is the time from a positive peak to the next
negative peak (trough). The time trough-to-peak (Time TP) is the time from a
trough to the next positive peak.

Figure A--6 shows how the Time PT and Time TP measurements are defined.

Time PT

Time TP

Peak

Trough

Figure A- 6: Time PT and Time TP measurements

Calculating Statistics

The application calculates statistics for each selected measurement, and logs the
statisitcs on a cycle-cycle basis in a fairly large waveform. The standard statistics
are for the Maximum, Minimum, Mean, and Standard Deviation.

The application continues to calculate statistics until you press the Reset button
in the Sequence Control menu. This resets all values to zero.

The application calculates this statistic using the following equation:

Max (X) = Highest value of X

The application calculates this statistic using the following equation:

Min (X) = Lowest value of X

Time Peak-to-Trough
(Time PT) and

Time Trough-to-Peak
(Time TP)

Maximum Value

Minimum Value
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The application calculates this statistic using the following equation:

Mean (X) = X =
1
N
�
n=1

N

Xn

It may seem odd that the equation for the estimate of the Standard Deviation
contains a 1/(N--1) scaling factor. If you knew the true mean of X and used it in
place of the estimated mean X, then you would, in fact, scale by 1/N. But, X is an
estimate and is likely to be in error (or bias), causing the estimate of the Standard
Deviation to be too small if scaled by 1/N. This is the reason for the scaling
shown in the equation. (Refer to Chapter 9.2 in A. Papoulis, Probability,
Random Variables, and Stochastic Processes, McGraw Hill, 1991.)

The application calculates this statistic using the following equation:

Standard Deviation (X) = σx =
1

(N–1)
�
N

n=1

(Xn – X)2�

Mean Value

Standard Deviation Value



Appendix A: Measurement Algorithms

A- 16 TDSDDM2 Disk Drive Measurements Application User Manual



TDSDDM2 Disk Drive Measurements Application User Manual B- 1

Appendix B: Track Profile Plots

Track Profile plots are reference memory waveforms that contain measurement
results from each track sector. The results are distributed over a 500 point record.
You can use track profiles to help analyze a measurement in the following ways:

� Observe sector-to-sector variations in measurements

� Identify the location of flaws within a track

� Observe characteristics of measurement variations around a track which may
be due to causes such as head height variations or surface media defects

The resulting Track Profile plot represents the value of the measurement as a
function of sector number over a range of sectors, which can be specified in the
Inputs/Trigger menu. The Trigger Mode must be set to Sector and you have to
use the vertical cursors on the oscilloscope for the application to display the
Sector at Cursor readout.

For an example of a Track Profile plot with readouts, refer to Figure 2--42 on
page 2--47.

Using Track Profiles

To create a Track Profile plot, follow the procedure on page 2--45.

To view ongoing track profile results, set the Sequence Mode to Free Run. When
the Track Profile plot reaches its 500-point capacity, the application continues to
acquire data and the plot scrolls across the screen as new points are added and
old points are deleted. For an example of this, refer to Figure 2--41 on page 2--46.

About the Track Profile Reference Memory

At the beginning of the measurement, the reference memory is filled with null
values. At the end of each sector measurement, the value for that measurement is
stored in the reference memory and a display cycle is activated. This causes the
reference memory waveform to sweep across the screen as the measurement
progresses around the track. You then have a clear indication of the progress of
the entire measurement over the specified range of sectors.

Values are stored in the reference memory as one point per measurement result,
up to a maximum of 500 points. If more than 500 points/measurements are
taken, the oldest results are discarded. Any unused points at the end of the
reference memory record are set to null values.
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Appendix C: GPIB Command Syntax

This appendix describes the GPIB command syntax that you can use in your
GPIB program to do the following tasks:

� Start the TDSDDM2 application

� Recognize an active application with GPIB protocol

� Program and read application setup parameters

� Sequence measurements

� Read measurement results

To use GPIB commands with your oscilloscope, you can use the following
reference materials:

� The tdsddm2ctrl.c file on the oscilloscope hard drive and on the optional
applications compact disc contains an example of a GPIB program that can
execute the application

� The GPIB Program Example section for guidelines to use while designing a
GPIB program

� The Parameters Reference section for incremental units and default values of
TDSDDM2 parameters

� The programmer information in the online help of your oscilloscope

Description.Gives the function of the command, conditions of its use, and its
interactions with other commands.

Syntax.Gives the valid select and query command forms. The required argu-
ments are listed in their proper order.

For example, in the syntax definition

PATH= <Ad><Ars>

the arguments <Ad> and <Ars> are required in the order indicated

Arguments. The arguments to a command are defined along with their range of
values.

Returns.Defines the data returned in response to a command query.
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Starting the Application

To start the TDSDDM2 application, you must send the oscilloscope the
following GPIB command:

application:activate ”Disk Drive Measurements 2”

VARIABLE:VALUE TDS COMMAND

VARIABLE:VALUE TDS COMMAND accepts string arguments for a control or
data variable and a value to which to set the argument.

VARIABLE:VALUE

VARIABLE:VALUE “<variable name>”,“<variable value>”

the arguments <variable name> and <variable value> are required

in the order indicated.

VARIABLE:VALUE? “<variable name>” for query

Table C--1 lists the arguments, their function, and the query returns.

CAUTION. Commands are case and space sensitive. Your program will not

operate correctly if you do not follow the capitalization and spaces precisely.

Table C- 1: VARIABLE:VALUE TDS COMMAND arguments and queries

Variable name Variable value Function Query form

application exit Terminates the active applica-
tion

Returns the name of the
active application

measurement {TAA, TAA+, TAA--, Snapshot TAA,
PW50, PW50+, PW50--, Snapshot
PW50, NLTS Initial, NLTS 1st Adjacent,
NLTS 2nd Adjacent, Snapshot NLTS,
SNR, Overwrite, Resolution, Asperity,
Baseline Shift}

Sets the type of measure-
ment to take

Returns the measurement
currently selected

Limits

limitTest Query only Returns “ ” when Off and
Pass or Fail when On

limitTestState {On, Off} Sets the state of the limit test Returns the state of the limit
test

Description

Syntax

Arguments and Returns
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Table C- 1: VARIABLE:VALUE TDS COMMAND arguments and queries (Cont.)

Variable name Query formFunctionVariable value

limitTestUpper String corresponds to a positive double* Sets the upper limit value Returns the upper limit value

limitTestLower String corresponds to a positive double* Sets the lower limit value Returns the lower limit value

NLTS/Other

patternDuration String corresponds to a double positive For NLTS measuements, sets
the initial length of time for
the pattern duration value

For SNR measurements, sets
the number of bits per pattern
period for general patterned
data

Returns the pattern duration

durationTolerance String corresponds to a positive integer Sets the tolerance (accuracy)
of the pattern duration

Returns the tolerance

polynomialIndex String corresponds to a positive integer Sets the selected pseudo-ran-
dom binary sequence poly-
nominal value

Returns the polynominal
index

bitsPerPattern String corresponds to a positive integer For SNR measurements, sets
the type of periodic signal

Returns the bits per pattern

threshold String corresponds to a positive double* Defines threshold for Asperity Returns the value set for the
threshold

Input channels

readSignal {Ch1, Ch2, Ch3, Ch4, Ref1, Ref2, Ref3,
Ref4, Math1, Math2, Math3, Math4}

Sets the Read Signal input to
a waveform

Returns the Read Signal
selection

readGate {Ch1, Ch2, Ch3, Ch4} Sets the Read Gate input to a
waveform

Returns the Read Gate selec-
tion

indexPulse {Ch1, Ch2, Ch3, Ch4} Sets the Index Pulse input to
a waveform

Returns the Index Pulse
selection

sectorPulse {Ch1, Ch2, Ch3, Ch4} Sets the Sector Pulse input to
a waveform

Returns the Sector Pulse
selection

Trigger

triggerMode {Index, Read Gate, Sector, User} Sets the trigger mode Returns the trigger mode

preambleDuration String corresponds to a positive double* Sets the value of the
preamble duration

Returns the value of the
preamble duration

startSector String corresponds to a positive integer Sets the sector on which the
measurement starts

Returns the sector on which
the measurement starts

stopSector String corresponds to a positive integer Sets the sector on which the
measurement stops

Returns the sector on which
the measurement stops

Filters

filter1CutoffFreq or
filter2CutoffFreq

String corresponds to a positive double* Sets the cutoff frequency Returns the cutoff frequency
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Table C- 1: VARIABLE:VALUE TDS COMMAND arguments and queries (Cont.)

Variable name Query formFunctionVariable value

filter1DestinationName or
filter2DestinationName

{Ref1, Ref2, Ref3, Ref4, None} Sets the filter destination to a
Ref or to none

Returns the filter destination
selection

filter1Slope or
filter2Slope

{12 dB/oct, 24 dB/oct, 36 dB/oct, 48
dB/oct, 60 dB/oct, 72 dB/oct, 80 dB/oct}

Sets the slope of the filter in
dB units

Returns the slope of the filter
in dB units

filter1State or
filter2State

{On, Off} Sets the state of the filter Returns the state of the filter

filter1Type or
filter2Type

{Lowpass, Highpass} Sets the type of filter Returns the type of filter

General

gating {On, Off} Sets the state of gating Returns the state of gating

hysteresis String corresponds to a double positive Sets the hysteresis value Returns the hysteresis value

Sequencer

sequencerMode {Free Run, Single} Sets the Sequencer Mode Returns the Sequencer Mode

sequencerState {Ready, Paused, Sequencing} Sets the state of the
sequencer

Returns the state of the
sequencer

Profiler

profilerState {On, Off} Sets the state of the Profiler
plot

Returns the state of the
Profiler plot

profilerDestination {Ref1, Ref2, Ref3, Ref4} Sets the destination reference
memory of the Profiler plot

Returns the destination refer-
ence memory of the Profiler
plot

Logging Results

<meas>logAnnotate* Any string from 1 to 20 characters from A
to Z and/or zero to nine

Provides custom annotation
to the statistics log file; see
measurement in this table for
<meas> choices

Returns annotation value if
set

<meas>loggerDestination Any string from 1 to 8 characters from A
to Z and/or zero to nine

Sets the statistics log file
name; see measurement in
this table for <meas> choices

Returns the statisics log file
name

<meas>logger {Reset} Clears the current statistics
log file; see measurement in
this table for <meas> choices

No query form

<meas>loggerState {On, Off} Sets the state of the statistics
log; when on, the statistics
from the current acquisition
are logged; see measurement
in this table for <meas>
choices

Returns the state of the data
log

* You can enter positive double values two ways; for example, 0.000256 or 2.56E-4 (IEEE format).
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Table C- 1: VARIABLE:VALUE TDS COMMAND arguments and queries (Cont.)

Variable name Query formFunctionVariable value

Save/Recall

setup {Default, Recall, Save} Causes a Save or a Recall to
occur

No query form

recallName Any string from 1 to 8 characters from A
to Z and/or zero to nine

Sets the recalled setup file
name

Returns the recalled setup file
name

saveName Any string from 1 to 8 characters from A
to Z and/or zero to nine

Sets saved setup file name Returns the saved setup file
name

Result Variables

resultFor {TAA, TAA+, TAA--, Snapshot TAA,
PW50, PW50+, PW50--, Snapshot
PW50, NLTS Initial, NLTS 1st Adjacent,
NLTS 2nd Adjacent, Snapshot NLTS,
SNR, Overwrite, Resolution, Asperity,
Baseline Shift}

Sets the measurement for
which results are requested

Returns the selected measur-
mentt; see Table C--2 for the
queries associated with
resultFor

* Custom annotation in the data log file is only available through GPIB execution of the application.

Before you can request result queries, be sure that your program contains the
following sequence of GPIB commands:

measurement

sequenceMode

sequenceState

resultFor

After this sequence, you can query the results. If you have a subsequent
sequencing for the same measurement, you must issue another resultFor
command.

You need to use the VARIABLE:VALUE? form to enter measurement results
queries in your GPIB program. Table C--2 lists the measurement results queries
for the measurement selected in the resultFor variable.

Table C- 2: Measurement results queries

Variable name Function

1st adj trans Returns the NLTS value caused by a transition in the previous bit cell,
which opposes the transition in the current bit cell

2nd adj trans Returns the NLTS value caused by a transition, which is two bit cells
before the current bit cell
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Table C- 2: Measurement results queries (Cont.)

Variable name Function

Amplitude asymmetry For TAA Snapshot measurements only; returns the percent of
amplitude asymmetry with zero indicating total asymmetry

asperity {0 to 9} Returns the sector number and time in which the asperity occurred for
no more than the last 10 asperities

Estm Pattern Duration Returns the estimated duration of the pattern

frequency Returns the frequency value

init mag Returns the initial magnetization value for NLTS only

m1 Returns the magnitude value for the low frequency signal

m2 Returns the magnitude value for the high frequency signal

max Returns the maximum value

mean Returns the mean value

meanPercent Returns the mean value as a percentage for the Baseline Shift
measurement

min Returns the minimum value

num avg Returns the number of peaks, troughs or peak/trough pairs used for
the average values

numAvgAtF1 Returns the number of peak and trough pairs of the high frequency
pattern

numAvgAtF2 Returns the number of peak and trough pairs of the low frequency
pattern

overwrite Returns the amount of residual signal remaining from a previous write
when new data is written to the same location

pass Returns Pass 1 or Pass 2 for the Resolution and Overwrite
measurements

PW50 Returns the average pulse width at 50% of the peak value measured
around a complete track

PW50+ Returns the average pulse width at 50% of the positive peaks value

PW50-- Returns the average pulse width at 50% of the negative peaks value

PW50 res Returns the number of samples for Pulse Width 50%

resolution Returns the total number of samples

sector number Returns the number of sectors included in the measurement

statSNR Returns the statistics for the SNR measurement

stdDev Returns the standard deviation value

TAA Returns the average peak-to-peak value of data from the Read
waveform

TAA+ Returns the average positive peak value
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Table C- 2: Measurement results queries (Cont.)

Variable name Function

TAA-- Returns the average negative peak value

taaAtF1 Returns the TAA value of the high frequency pattern

taaAtF2 Returns the TAA value of the low frequency pattern

Time asymmetry Returns the ability of the head and the media to process positive and
negative transitions identically; only for TAA and PW50 snapshots

Time PT Returns the value of the elapsed time from a positive peak to the next
negative peak (trough)

Time TP Returns the value of the elapsed time from a negative peak (trough) to
the next positive peak

total asperities Returns the total number of asperities

User Pattern Duration Returns the actual duration of the pattern

Table C--3 lists the results returned for various measurements.

Table C- 3: Results returned by measurements

Measurement Results returned

TAA, TAA+, TAA--,
PW50, PW50+, PW50--

mean, max, min, stdDev, statSNR, num avg, sector number

Snapshot TAA TAA, TAA+, TAA--, Amplitude asymmetry, num avg, Time PT, Time
TP, Time Asymmetry, resolution, frequency, hysteresis, sector
number

Snapshot PW50 PW50, PW50+, PW50--, PW50 res, num avg, Time PT, Time TP, Time
asymmetry, resolution, frequency, hysteresis, sector number

NLTS Initial, NLTS 1st
Adjacent, NLTS 2nd
Adjacent

mean, min, max, stdDev, num avg, sector number, User Pattern
Duration, Estm Pattern Duration

Snapshot NLTS init mag, 1st adj trans, 2nd adj trans, num avg, sector number, User
Pattern Duration, Estm Pattern Duration

SNR mean, min, max, stdDev, num avg, sector number, User Pattern
Duration, Estm Pattern Duration

Asperity total asperities, sector number, asperity{0-9}

Overwrite pass, overwrite, m1, m2, frequency, sector number

Resolution pass, resolution, taaAtF1, numAvgAtF1, taaAtF2, numAvgAtF2, sector
number

Baseline Shift meanPercent, mean, max, min, stdDev, statSNR, num avg, sector
number



Appendix C: GPIB Command Syntax

C- 8 TDSDDM2 Disk Drive Measurements Application User Manual



Index





TDSDDM2 Disk Drive Measurements Application User Manual Index--1

Index

Symbols
.csv file

custom annotation with GPIB command, 2--21
example, 2--17
format, 2--20
viewing, 2--29
viewing in a spreadsheet program, 2--21

A
acquiring data

reset results, 2--16
Sequence mode, 2--15
waveforms, 2--15

address, Tektronix, xiii
Amplitude Asymmetry, A--13
application

basic functions with an oscilloscope, 2--2
closing, 2--3
description, 1--1
directory names, 2--3
enabling, 1--8
exiting, 2--24
file name extensions, 2--3
GPIB program example, 2--50
installing

compact disc, 1--7
floppy disk, 1--7

interface, 2--1
logging results, as statistics, 2--19
menu structure, 3--1
minimizing and maximizing, 2--2
recalling setups, 2--21
returning, 2--3
saving results to a file, 2--19
saving setups, 2--21
setting up

configuring measurments, 2--9
selecting measurments, 2--4

updates, 1--2
viewing results

as plots, 2--18
as statistics, 2--18

application examples, 2--33
Asperity measurement, 2--37
Baseline Shift measurement, 2--40
configuration, 2--34

filters, 2--35

gating, 2--34
hysteresis, 2--35
limit test, 2--34
range of sectors, 2--34

NLTS measurement, 2--41
Overwrite measurement, 2--38
PW50 measurement, 2--36
reference waveforms, 2--35
Resolution measurement, 2--40
SNR measurement, 2--43
TAA measurement, 2--35
Track Profile plot

creating, 2--45
viewing, 2--46

waveform files, 2--33
area, definition, 2--2
Asperity measurement

application equation, A--9
example, 2--37
parameter options, 2--9
parameter values, 3--6

B
Baseline Shift measurement

application equation, A--11
example, 2--40
Limit Test area, 2--5

parameter values, 3--4
box, 2--2
Browse button, 2--20
buttons

command, 2--2
option, 2--2
Sequence Control, 2--15

C
changing settings during a measurement, 2--16
channel assignments, 1--9, 1--16
Clear command button, 2--20
closing the application, 2--3
command button, 2--2
command syntax, GBIP protocol, C--1
compact disc, 1--7
configuration, 1--11
connecting to a system under test, 1--8
contacting Tektronix, xiii
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conventions, xii
Cutoff Frequency, updating values when sample rate is

changed, 2--13
cutoff frequency, 2--11

D
data log file

Clear button, 2--20
custom annotation with GPIB command, 2--21
example, 2--17
format, 2--20
Save Current button, 2--20
saving the results tutorial lesson, 2--29
viewing, 2--21

default setup, 2--24
dim menus or options, 1--2
directory names, 2--3
discontinuity, Gating to filter out, 2--13
disk drives, unsupported, 1--2
downloading updates, 1--2

E
enabling the application, 1--8
exiting the application, 2--24

F
file name extensions, 2--3
filtering out information for analysis, 2--16
Filters area

Cutoff Frequency, changing the sample rate, 2--13
filter characteristics, 2--12
option descriptions, 2--11
parameter values, 3--7
using both Highpass and Lowpass, 2--12
using both Highpass and Lowpass filters, 2--12

floppy disks, 1--7
Free Run sequence mode, 2--15

G
Gating, filter out discontinuity, 2--13
Gating option, 2--14
GPIB protocol

case sensitive, C--2
command syntax, C--1
custom annotation for the data log file, 2--21
guidelines, 2--49
oscilloscope operation, xi

program example, 2--50
grayed out menus or options, 1--2

H
Help menu, no parameters, 3--8
help, online, 2--2
Highpass and Lowpass filters, using both, 2--12
Highpass filter, 2--11
hysteresis, 1--14
Hysteresis option, 1--15, 2--14

I
IDEMA Disk Drive Standard, xii, A--1
Index Pulse definition, 2--10
Index Trigger mode, 1--13, 1--16
Inputs Filters menu, Read Signal input. See Filters Area
Inputs General menu, 2--14

descriptions, 2--14
Gating option, 2--14
Hysteresis, 1--14
Hysteresis option, 2--14
parameter values, 3--7

Inputs/Trigger menu, 2--9
Input Channels area, 1--16

descriptions, 2--9
parameter values, 3--6

Trigger area
descriptions, 2--10
parameter values, 3--6

installation
application

compact disc, 1--7
floppy disk, 1--7

disk drive connection
Primary setup, 1--9
Secondary setup, 1--10

downloading updates, 1--2
up-to-date procedures, xii

interface, application, 2--1

J
JRE, 1--6

K
keypad entry, 2--5
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L
label, location on oscilloscope, 1--5
leaving the application, 2--24
lessons. See tutorial lessons
Limit Test area

NLTS/Other, 2--5
parameter values, 3--4

TAA/PW50, 2--5
parameter values, 3--3

value entry methods, 2--5
list box, 2--2
localizing measurements, 2--16
log file, example, 2--17
Log Statistics menu, 2--19

parameter values, 3--8
Lowpass and Highpass filters, using both, 2--12
Lowpass filter, 2--11

M
maximizing the application, 2--2
Maximum statistics, application equation, A--14
Mean statistics, application equation, A--15
measurements

application equations
Asperity, A--9
Baseline Shift, A--11
NLTS 1st Adjacent, A--8
NLTS 2nd Adjacent, A--8
NLTS Initial, A--7
Overwrite, A--10
PW50, A--4
PW50+, A--5
PW50--, A--5
Resolution, A--11
Snapshot
Amplitude Asymmetry, A--13
Time Asymmetry, A--13
Time PT (peak-to-trough), A--14
Time TP (trough-to-peak), A--14

SNR, A--9
statistics
Maximum, A--14
Mean, A--15
Minimum, A--14
Standard Deviation, A--15

TAA, A--2
TAA+, A--3
TAA--, A--3

focusing on a part of the waveform, 2--16
GPIB program example, 2--50
localizing, 2--16

oscilloscope changes, 2--16
setting up, 2--4
Snapshot, A--12
taking, 2--15
test algorithms, A--1
tutorial lessons, 2--25

Measurements menus
Minimize, 2--2
NTLS/Other, 2--6
Save/Recall, 2--21
TAA/PW50, 2--4

menu structure, overview, 3--1
menus

Help, 2--2
Inputs

Filters, 2--10
General, 2--14
Inputs/Trigger, 2--9

Log, Statistics, 2--19
Measurements

NLTS/Other, 2--6
Save/Recall, 2--21
TAA/PW50, 2--4

Plot Track Profile, 2--18, B--1
Sequence Control, 2--15
View, Results, 2--18

Minimize menu, no parameters, 3--6
minimizing the application, 2--2
Minimum statistics, application equation, A--14
MP knob, 2--5
multipurpose knob entry, 2--5

N
NLTS measurements

algorithms, A--6
application equation

NLTS 1st Adjacent, A--8
NLTS 2nd Adjacent, A--8
NLTS Initial, A--7

example, 2--41
Limit Test area, parameter values, 3--4
parameter options, 2--6
parameter values, 3--5

NLTS/Other menu, 2--6
Limit Test area, 2--5

not enough cycles, error message, 2--16

O
online help, 2--2
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option button, 2--2
Option Installation key, 1--8
oscilloscope

accessing functions, 2--3
basic functions with the application, 2--2
compatibility, 1--1
full display, 2--3
setup guidelines, A--1

Overwrite measurement
application equation, A--10
example, 2--38
Limit Test area, 2--5

parameter values, 3--4

P
parameters, reference, 3--3
phone number, Tektronix, xiii
Plot Track Profile menu, 2--18

descriptions, 2--18
parameter values, 3--8

polynominal index calculation, 2--8
Preamble option, duration, 1--14, 2--16
product

compatibility, 1--1
description, 1--1
requirements and restrictions, 1--2
updates, 1--2

product support, contact information, xiii
PW50 measurements

algorithms, A--3
application equation, A--4

PW50+, A--5
PW50--, A--5

example, 2--36
Limit Test area, 2--5

Q
quitting the application, 2--24

R
Read Gate definition, 2--9
Read Gate Trigger mode, 1--13, 1--16
Read Signal

definition, 2--9
filtering, 2--10

Readme.txt file
floppy disk, 1--7
web site, 1--2

recalling
setups, 2--23
waveforms to reference memory, 2--26

reference memory
recalling waveforms, 2--26
Track Profile plot, B--1

requirements and restrictions, 1--2
Reset All, 2--16, 2--19
Resolution measurement

application equation, A--11
example, 2--40
Limit Test area, 2--5

parameter values, 3--4
results, reset and clear, 2--19
returning to the application, 2--3

S
sample rate, changing when using filters, 2--13
Save Current button, 2--20
Save/Recall menu, 2--21

parameters, 3--6
saving a setup, 2--22
sector 0, trigger setup, 1--14
sector pulse, absence to mark the beginning of a track

and trigger setup, 1--9
Sector Pulse definition, 2--10
Sector Trigger mode, 1--13, 1--16
Sequence Control, buttons, 2--15
Sequence Control menu, parameters, 3--9
Sequence mode, 2--15
service support, contact information, xiii
setups

default, 2--24
Primary, 1--9
recalling, 2--23
saving, 2--22
Secondary, 1--10
trigger for disk drives that do not use a sector pulse,

1--9
trigger on sector 0, 1--14

Single sequence mode, 2--15
slope, 2--11
Snapshot measurements

application equations, A--12
descriptions, 2--4

SNR measurement
application equation, A--9
example, 2--43
Limit Test area, parameter values, 3--4
parameter options, 2--8
parameter values, 3--5
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Standard Deviation statistics, application equation, A--15
statistics, application equation

Maximum, A--14
Mean, A--15
Minimum, A--14
Standard Deviation, A--15

system under test, 1--8

T
TAA measurements

algorithms, A--1
application equation, A--2

TAA+, A--3
TAA--, A--3

example, 2--35
Limit test area, 2--5
tutorial lesson, 2--27

TAA/PW50 menu, 2--4
Limit Test area, parameter values, 3--3

taking measurements, 2--15
technical support, contact information, xiii
Tektronix, contacting, xiii
terms, xii
Time Asymmetry, A--13
Time PT, A--14
Time TP, A--14
Track Profile plot

example, 2--45
menu, B--1
parameter options, 2--18
parameter values, 3--8

track triggering, 1--14
transient response, 2--13
Trigger area

descriptions, 2--10

modes, 1--13
parameters, 1--12

trigger setup
application, 1--12
disk drives that do not use a sector pulse, 1--9
oscilloscope, 1--11
sector 0, 1--14

tutorial lessons, 2--25
See also exiting the application; recalling a setup;

saving a setup
saving the results to a data log file, 2--29
TAA measurement, 2--27

U
Update command button, 2--11
URL, Tektronix, xiii
User Trigger mode, 1--13

V
value entry methods, 2--5
VARIABLE:VALUE TDS COMMAND, C--2
View Results menu

description, 2--18
no parameters, 3--8

viewing results
as plots, 2--18
as statistics, 2--18

W
web site

downloading updates, 1--2
Tektronix address, xiii
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